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Foreword 
 
Thank you for purchasing this quality Xitron product. We hope you will come to rely on Navigator Server as a powerful 
productivity tool.  
 
The Navigator suite of products may be sold separately or collectively.   
The essential components are: 
 
Navigator Server 
Navigator Client  
Navigator RIP 
 
Both the Server and the RIP have optional modules available to extend function. 
 
This manual explains how to install and use Navigator Server and Client and includes example workflow ideas that may 
help you get the best value from your investment. There are separate manuals available for the RIP and for optional Server 
and RIP modules.  They are available on our installation disk and on our web site. 

 
If you need help, contact your supplier or visit our web site at www.xitron.com. 
 
  

Chapter 1 – About Navigator Server and Client 

 

1.1 Overview 

Navigator Server is a workflow architecture for prepress and pressroom production.  Preflight, Ink mapping, Color 
management, proofing, RIP, Trapping, Imposition, automated press ink key configuration, and other modules are all part 
of the Navigator Server framework. 
Navigator Server provides multiple features for simplifying and empowering prepress workflows. 
Particularly valuable for high volume environments is Navigator Server’s load balancing capability. 
 
Navigator Client provides a single, simple user interface from which users - from their own desktops - can monitor jobs 
through various production stages. Users can view, modify, delete, re-process and generally manage their work without 
leaving their desks and without learning the complex user interface of a RIP. 
 
By using Navigator Server, operators can track thousands of jobs from their Windows or Macintosh clients.  
 

1.2 Navigator Server 

Navigator Server runs on a PC.  It requires Windows 7, Windows 8.1, or Windows 10.  No “Home Edition” versions of 
Microsoft’s operating systems are supported. By default, Navigator Server runs on the same computer as the RIP. 
However, you may configure more complex multi-computer systems. 
 

http://www.xitron.com/
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Navigator Server handles system security (licensing) and requires a dongle to run. However, for trial purposes, Navigator 
Server can be configured to share the Navigator RIP dongle for a period of 45 days. You will need a password if you wish 
to use optional modules during the free trial period.  
 
Clients will run without dongles and the Server will accept as many Clients as are currently permitted by the system. 
Upgrading to support additional Clients is a simple process of entering a security code into the Server to update the 
permissions. This Server upgrade menu is called “Product Features.”  Contact your dealer to purchase additional 
permission codes. 
 
Operation without a Navigator Server dongle  
Without a dongle but with a local connected RIP providing system security, Navigator Server operates as follows: 
For a 45-day trial period, a full standard Job Manager will function.  
With the addition of passwords, the Trial Mode can also be used with optional modules. 
After the 45-day trial period, users may purchase Navigator Server to continue its use.  
 
Operation with a Navigator Server dongle 
The Navigator Server handles system security (with the exception of connected RIPs). Therefore, Navigator Client 
platforms do not need dongles. The Server will accept as many Client connections as are currently licensed.  
Upgrades to the system can be handled with license codes. 

1.3 Navigator Clients 

Navigator Clients are available for PCs running Windows XP, 2003, Vista, Windows 7, and Mac OSX 10.4 and higher.  
 
The Client provides the regular user interface to the system, after completion of basic system configuration. Users may 
connect to the Navigator Server and, subject to their access privileges, create or modify workflows and manage jobs.  
 
The system saves the user’s work and job status so the user can connect via another Client on another computer and see 
their work as they would expect. 
 
Clients allow users to: 
 

 Create, modify or delete workflows. 

 See jobs in the system using a number of different views. 

 Review jobs that are held at various workflow stages. 

 Release, delete or re-submit jobs. 

 Soft proof jobs on screen before final output. 

 Check traps, separations, spot colors etc. 
 
Additional options are available to: 
 

 Create PDF Files 

 Preflight PDF Files and review PDF Preflight Reports 

 Participate in a certified PDF workflow 

 Remap ink color separations 

 Impose pages 

 Recombine and descreen TIFF Files for ROOM proofs 

 Automatically set ink ducts on a press console 





 

 
 

Chapter 2 – Server Installation 
 

2.1  Introduction 

The Navigator disk will automatically launch the install screen. Five different buttons are available. 
1. Server & RIP (Installs our complete workflow with the RIP.) 
2. Server (Installs Navigator Server components only. No RIP.) 
3. RIP (Installs the Navigator RIP only. No workflow.) 
4. RIP Plugins (Installs output device support plugins; e.g. Epson proofers, Screen CTP, etc.) 
5. Documentation (Launches our documentation in your PDF reader.) 

2.2 Users and Shared Folders 

Navigator Server makes extensive use of shared folders. These are folders on one computer that are accessible over the 
local area network by other computers. Navigator Clients must have read and write access to these shared folders on the 
Navigator Server PC. If the proper permissions are not granted, Navigator Clients will not function properly. 
In multi box installations (defined as Navigator Server running on a computer separate from any of the RIPs it controls), 
Navigator Server must have read and write access to the share created by the “RIP Utilities” install on the RIP PCs.  

2.3 Installing an Upgrade to an Existing Navigator Server or RIP Manager System  

“Load over” upgrades will work.  This consists of installing the software to the same directory as the old version.  See 
Appendix B for useful and up to date upgrade information. 

2.4 Installing Navigator RIP Only 

If you wish to install the RIP without the Server, insert the CD and select the “Navigator RIP” option from the installer 
splash screen.  
Once complete, insert the Navigator Plug-ins CD and follow the on-screen prompts to install any additional plug-ins. 
For more details see the Navigator Installation Guide. 

2.5 Installing Navigator Server Only 

If you are upgrading an existing RIP-only system to use Navigator Server, select the “Navigator Server” option from the 
installer splash screen.   There will be four choices. Choose “Server,” as shown below.    

Server Install Selection 

 

 
After the Server installation is complete you must establish control of your Navigator RIP. Check that your RIP has a page 
setup called “Default Page Setup”, which should have been created when the RIP was installed. If you have renamed or 
deleted this page setup, you must create a new one as follows: 
 
From the RIP’s Page Setup Manager dialog box, click New. In the Page Setup Edit dialog box, click Save As… Enter the 
exact name “Default Page Setup” and click Save.  
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To properly manage your workflow, Navigator Server must install several software components on the RIP platform. This 
step must be carried out on the PC containing the RIP, which may be different from the platform on which you’ve installed 
the Navigator Server software. 
  
If the RIP is running, quit the application. Launch the Navigator Server Installer as above, but select the “RIP Utilities” 
radio button.  
 
 
 

RIP Utilities 

 
 

 
The installation of the RIP Utilities will create a share on the RIP computer.  You need to ensure that the share is accessible 
by Navigator Server.  This share is named “xipgb_<machine-name>”.  You may find the correct path to this share by 
opening a Command Prompt (CMD) and typing “Net share”. 
 
Click Permissions and check the boxes that Allow Everyone full permissions, including Full Control, Change, and 
Read, as shown in the next figure, Sharing Properties and Permissions. 
 
See section 3.4 for further information about access rights.  
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Sharing Properties and Permissions 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
After completing the sharing setup, launch the RIP.  

 
The RIP Utilities Installer will also create two Input Sockets on your RIP. Navigator Server will use these inputs to 
communicate with older RIPs.  
 
If you are using a version 7, 8 or 9 RIP, the RIP Utilities Installer will create a connection to the RIP that is invisible to the 
user. 
 
Repeat this process at each RIP you wish to control through Navigator Server. Keep in mind that Navigator Server, under 
the “Workflow Actions” menu, must be configured with a RIP action for each RIP you wish to control.  Details for this 
procedure follow. 
 

2.6 Platform Requirements 

Check the Xitron web site for the current system requirements by clicking this link: Minimum computer platform 
requirements. 
 

http://www.xitron.com/prepress/navigator/navigator-rip
http://www.xitron.com/prepress/navigator/navigator-rip
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Chapter 3 – Navigator Workflow Installation 
 

3.1 Navigator Workflow  

Make sure no security dongles are attached to the PC. After inserting CD 1, the installation splash screen will appear. 
Choose Navigator Workflow from the menu.    
 
The on-screen prompts will guide you through the entire installation.  At times, the system may ask for license codes 
necessary for certain options. Refer to the code sheet that came with your system and enter the codes as appropriate. If you 
are not prompted during the installation, enter your license codes at the RIP under the Navigator, Configure RIP menu 
selection. 
 

3.2 Restart your PC 

After installing all components and re-attaching the Navigator dongle, re-start the PC.  

 

3.3 RIP Configuration 

Navigator Server can be imagined as a replacement for the Harlequin Input and Output Controller windows.  
Consequently, where you would have formerly set up Inputs in the Input Controller for corresponding Page Setup 
configurations, you now set up Navigator Server workflows.  Output Controller is not needed for its job control, queuing, 
previewing, or hold and release functions. Navigator Server now handles all these and more. To facilitate this, set the 
Output Controller to Delete Always and uncheck Disable Output, as shown below. 
 

Output Controller Configuration 

 
 
 

Configure Page Setups from within the RIP menu by selecting Navigator, Page Setup Manager.  Do not delete the 
default page setups.  Once this initial configuration is completed, users will be able to select these Page Setups from 
within the Navigator Client application at any Mac or PC on which it is installed.  See the Navigator Reference Guide for 
more information on RIP configuration.  All Xitron Manuals are available by clicking here.   

 

3.4 Special Settings for Windows XP Professional, Vista, Windows 7 and newer OS’s 

When running Navigator Server - or a RIP connected to Navigator Server - on Windows Operating Systems since XP, it is 
necessary to adjust various sharing and security settings.  
 

http://www.xitron.com/doco_techbulletins.htm
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Simple File Sharing 
The default configuration upon installation of Windows XP, Vista, and other Windows OS’s is for “simple file sharing” to 
be enable. Before continuing, it must be turned off. To do so, follow these steps: 
 

Simple File Sharing 

 
 

1. Open a window. 
2. From the Tools menu select Folder Options . . . 
3. In the Folder Options window, select the View tab. 
4. Scroll to the bottom of the “Advanced settings:” list. 
5. Turn off Use simple file sharing as shown in the figure on page 10. 

 
 
Configure Shared Folders 
Next, it may be necessary to locate all the shared folders on the Windows platform associated with Navigator Server and 
the RIP(s) that Navigator Server will control. The normal locations of these folders are listed below: 
 
On the RIP computer: the share is located at <rip install directory>/ sw/page buffers/xiflowpgbdir. On the Navigator 
Server computer there are two shares.  They are located at <drive letter>:/Navigator /Workflows and <drive 
letter>:/Navigator /Jobs 
 
You can also get a list of the shares on your computer by opening a command prompt and typing net share. From the 
Start menu, select Run. Type cmd and press Enter. The command prompt will open. Type net share and a list of your 
shared folders will appear. 
 
To adjust the sharing settings properly for each Navigator Server share, complete the following steps: 
 

1. Locate each folder listed. 
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2. Place the mouse pointer over the folder and right-click. 
3. From the list that appears, choose Properties. 
4. From the Properties window that appears, select the Security tab. 

 Note: the Security tab will not be available if you have not turned off Simple File Sharing as indicated earlier. 
5. Under the Group or User names heading, click the Add...button. 
6. In the Select Users or Groups window that appears, type Everyone as illustrated below. 
 

Select Users or Groups 
 

 
 

7. After completing the Select Users or Groups window as shown above, click OK. This will return to the 
Properties screen and Everyone will appear in the Group or User names: list. 

8. Highlight Everyone” in the Group or User names list. 
9. In the permissions for Everyone list, click the check box to Allow Full Control. This will turn on all of the 

check marks under the Allow heading. The figure below shows the proper configuration. 
 

Allow Full Control 
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10. Click OK to close the Properties window. 
11. Repeat these steps for all of the shared folders 

 





 

 
 

Chapter 4 – Getting Started 
 

4.1 Launching the Software 

Verify the installation of your dongle before launching the application. Without the dongle, the License Manager will not 
allow the software to run. The dongle must be properly inserted into an available USB port. 
 
The Installer places a Short Cut for either the Navigator Server or the Launcher (depending on installation performed) on 
your desktop. The Server or Launcher will launch your RIP automatically.  When you wish to start or quit the RIP, 
start or quit the Navigator Server instead. 
 
Note: If your system has a Firewall installed you will see a number of alerts the first time the Navigator system starts. 
Programs that may ask for authorization include SOAR, JAVACORESOAR, PDFSERVER.EXE, XITRON.EXE and 
others. For each component, permit the software to run, and check the box to make this permission permanent. Once 
each component has been authorized it will not need further permissions.  
 

4.2 Launcher 

You may wish to reconfigure the Launcher not to launch a client at start up.  If you do not plan to use a client license on 
the system server, double-click the Launcher and click Configure.  The dialog box shown below will appear.  Uncheck 
the Enable button for Navigator Client. 
 
Notice that other applications may be started in order by the launcher as well.  This has proven useful in integrating non-
Xitron RIPs which rely on device utilities that start in a specific order.  The only order restriction is that Navigator client 
must come after the Navigator Server.  
 

Configure the Launcher 
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4.3 Page Setups 

The RIP stores configurations using a system of Page Setups.   You will need to create Page Setups in the RIP exactly as you 
would in a RIP installation without Navigator Server. To create or modify Page Setups, use the Page Setup Manager. If the 
Page Setup Manager appears grayed out, it may be because the RIP Inputs are enabled (on). Turn them off by clicking the 
traffic light icon with the red arrow.  RIP Inputs do not need to be on for any RIP version 7 or later.  Version 6 RIPs may 
be controlled via automatically- installed socket inputs.  
 
Create a new Page Setup using the New… button. Select the required output device, resolution etc. and select Save 
As… giving the new page setup a descriptive name. (Do not overwrite the name Default or delete the Default page setup. 
See the Navigator RIP Operator Manual if you are using the Navigator RIP- or the corresponding manual for any other 
Harlequin RIP - for details regarding page setups.  
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Chapter 5 – Server Configuration 
 

5.1 Introduction 

After launching the Navigator Server application, the Server Dialog appears on the Server PC: 
 

Navigator Server Dialog 
 

 

 
 

 

 
This window displays information about the Server including its serial number, name and other variables. You may display 
or hide the Tool Bar and Status bar through the View Menu. To exit the Server, use the File > Exit menu selection or the 
Exit button at the top right corner of the window. 
 
A special user account called Administrator has full rights to configure the Navigator Server. Upon installation, the 
Administrator password is blank. The only active menu item is Server Setup > Administrator Login. Choose this 
option, and click OK, leaving the password field blank. You now have access to the full range of Server features. Xitron 
strongly recommends setting a password for the Administrator user during initial set-up. Go to Server Setup > Users 
dialog (see section 5.2 below) to set the password. Any further changes to the configuration will require logging in as 
Administrator and entering the correct password.  
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The Navigator Server must be configured when it is installed and when changes to the system are required. The most 
common change after installation is the addition of new Users.  
 
Configuration options are: 
 

 Add, delete, or change Users 

 Upgrade product 

 Manage Actions (processes managed by the Server) 

 Set locations on the system for storing workflows and jobs 

 Set Server Name (for cases where there are more than one Server) 

 Set custom field names (for organizing and sorting jobs) 
 
Access these options via the Server Setup menu item, as discussed in detail in the following sections. 
 

5.2 User Management 

All system users must register with the Server. Depending on the options purchased, the system limits the number of 
Users who can simultaneously connect. However there is no limit to the number of users who can be defined at the Server. 
For example, you might have a 5-User system, but 12 employees who work different shifts. You can define 12 different 
Users at the Server, and any 5 of them can be connected at one time. If you wish to upgrade your system to support more 
simultaneous Users, this can be done via a password through the Upgrade Product dialog. 
 
To manage Users select the Server Setup > Users menu item. 
 
To create a new User 
Click Add, and enter the User name and Password as shown in the next figure labeled Create a User on page 16. 

 
Note that a password is not strictly necessary. If this field is left blank, this User may connect to the system without a 
password. Specify the User type by clicking one of the Radio Buttons. Choose Administrator or Standard User, or by 
clicking on the permissions button, create a Special User. The Permissions available are shown in the figure labeled User 
Permissions on page 16.  
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Create a User 

 

 
 
 

User Permissions 
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Depending on the type of User created, certain restrictions will apply. For instance, Administrators have all Permissions 
allowed while Standard Users can only Delete or Release jobs. Special Users are created if you select any other 
combination of Permissions. After establishing Permissions, click OK until the system returns to the User dialog shown 
earlier. Confirm the new User(s) is/are shown correctly.  
 
To Delete A User 
Access the Users dialog (Server Setup > Users menu), highlight the User to delete, and click Delete. 
 
To Modify a User Account 
Access the Users dialog (Server Setup > Users menu), highlight the User to change, and click Modify. Make the 
changes as outlined above for a New User. 
 
When all changes or additions are complete, click Done to close the Users dialog. 
 

5.3 Upgrade Product 

Navigator Server uses a security system based on the combination of a single system-wide dongle and a series of codes to 
enable or add specific functions. In addition, Navigator Server can run for up to 45 days in Trial Mode. If your system is in 
Trial Mode, all connected Clients will display the mode, and number of days left, at the top of the Client window. 
 
To convert a Trial Mode system to a full system it will be necessary to obtain codes and a dongle, from your supplier. 
Connect any new dongle and add codes by navigating to the menu item (Server Setup > Upgrade Features). The 
following dialog appears: 
 

Entering Upgrade Codes 

 

 
  
  

 
The upper portion of the window displays the dongle Serial Number; the maximum number of simultaneous Client 
connections; whether or not this system is a Trial (Demo system with an associated expiration date); the maximum 
number of RIPs that can be managed; the PGB Viewer Version, and the Product Version number. 
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In the lower center of the screen is a list of Actions that are available in the software. To the right of each Action is the 
word “Yes” if the Action is currently active or “No” if it is not. To enable currently disabled Actions, add a new RIP or 
Client connections, or change your PGB Viewer type, you must first obtain the appropriate code from your supplier.  
 
To install the upgrade, enter the code into the boxes at the base of the dialog and click OK. Upon verification by the 
system the option will be added or changed. 
 
Note: You will also need an upgrade code if you have upgraded from one product Version to another. For example 
upgrading from Version 2.x to Version 3.x will require a Version Upgrade code. If your system requires a Version 
Upgrade, the following dialog will appear after launching the Server application: 
 
 

Version Upgrade 

 

 
 

 

 
Enter the Version Upgrade code and click OK. 
 

5.4 Manage Actions 

“Actions” describe the individual steps or processes Navigator Server uses in the construction of workflows. For example, 
the RIP Action is a basic action that controls the RIP portion of a Navigator Server system. Other actions are optional, and 
the choices shown in the dialogs will depend on the version of Navigator Server as well as the options purchased. 
 
To configure Actions, select the menu item (Server Setup > Actions). The Actions Manager dialog will appear as 
shown in the figure on page 19. The install creates several actions. You may wish to create more. Only configured Actions 
will be available for Users creating workflows. 
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Actions Manager 
 

 
 

 

 

5.4.1 The RIP Action 

Before configuring the RIP Actions within Navigator Server, verify the RIP Utilities have been installed on the RIP. 
 
From Navigator Server’s Actions Manager click New, select  RIP  from the list of Workflow Agents, and name the Action. 
This is the name that users will see from their Client workstations so choose a name that will be helpful to your users; 
especially if you have more than one RIP. The following figure shows an example of a RIP Action dialog box: 
 

RIP Action Configuration 
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Note: If you are connecting a RIP that resides on the same PC as the Navigator Server, simply check the RIP is local… 
check box and the configuration will complete automatically. 
 
If you are configuring a RIP Action for a RIP that is not on the same PC as the Navigator server, use the Browse button to 
locate the shared xipgb folder (see Chapter 2) on the RIP.  Navigator Server will attempt to communicate with the RIP 
immediately.  
 
The timeout value is the length of time Navigator Server will wait for a job to be processed by the RIP before reporting an 
error. If you are processing complex jobs, particularly involving trapping, you may find the system reports an error when 
in fact the job is still running correctly. If so, set a larger value than 1200 seconds. Click OK twice to close the Workflow 
Actions Manager and return to the Server window. 
 
You may repeat this process with as many RIPs as your Navigator Server is licensed to support.  Multiple RIP support can 
take the form of several unrelated RIPs driving several unrelated devices or load balancing across RIPs driving similar 
devices.  
See section 6.4.3 for more information on multi-rip support. 
 
NOTE:  The “Submit PGBs to the RIP’s Output Controller as a group” selection is a compatibility check box for use 
with certain device output plug-ins.  Currently, the output plug-ins known to require it are Xitron’s Prism plug-in, 
Xitron’s Presstek plug-in, Presstek’s DI and Presstek’s Dimension plug-ins. 
 

5.4.2 The RIP Output Action  

If a RIP Action is configured in the Server (Server Setup > Manage Workflow Actions), both RIP Action and RIP Output 
Action will be enabled. The RIP Output Action will be named by appending ‘Output’ to the name of the RIP Action. 
 
The purpose of the RIP Output Action is to take input from a RIP Action which is configured to produce output suitable 
for a particular device, and to send that output to the device. So for the workflow configuration in the Client, a RIP 
Output Action must be preceded by a RIP Action which is associated with a Page Setup for an output device. 
 
The RIP Output Action configuration page in the Client is shown below.  
 

RIP Output Action Configuration 
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From Navigator Server v5.0 onwards, media saving options are provided, if the ‘Enable media saving options’ checkbox is 
checked. The options are as follows: 
 

 Output single rows  If this option is checked, the media saving engine will produce one or more outputs, each 
containing a single row of imposed pages. In other words, pages will not be grouped vertically; output will be 
produced as soon as there is sufficient to complete a row. 

 Rotate to save media  If this option is checked, the media saving engine may rotate pages by 90 degrees to 
achieve a more efficient layout and use less of the output media. 

 Media width and height  These fields control the width and height to which the output is constrained. 

 Horizontal and Vertical gap  These fields control the size of the gutter which will be included between pages 
by the media saving engine. 

 Units of measurement   Select the units to be used for the Media width and height, and the Horizontal and 
Vertical gap settings. Millimetres and Inches are available. 

 

5.4.3 Direct Output Action 

Direct Output is an alternative RIP Action that supports Harlequin RIPs version 8 and later.  Direct Output can be used in 
the same workflow as the RIP Action or separately.  It does not allow for a pause between RIP and output.  Commonly it 
is used for NORM proofing workflows.  There are other uses as well.  Direct Output supports any output device 
supported by the RIP.  Simply drag it into a workflow and choose a page setup to configure.  The simplest workflow 
possible would be a hotfolder and the Direct Output action alone.   

5.4.4 The Copy Action 

Use the Copy Action to create a copy of a job file and send it immediately to another workflow. This enables one job file to 
be used, for example, to create both low resolution and high resolution PDF files for different purposes. (To copy a file 
outside of Navigator Server, such as a Hot Folder providing input to an Imposition product, use the Export Action). To 
create a Copy Action, select the menu item Server Setup > Manage Actions. Click New Action, select Copy from 
the Workflow Agent list box, enter a suitable name and click OK. (No additional configuration is necessary when creating 
a Copy Action.) 
 
It is a good idea to name the copy action for the purpose it will be used. For example, to copy files to a workflow that 
processes proofs, a good name for the copy action would be “Proof”. 
 

5.4.5 The Export Action 

Use the Export action to send job files from Navigator to another location on the network. One example might be to send 
a low-resolution PDF file to a remote computer for Soft Proofing, but there are many other reasons you may wish to send 
the job file out of the Navigator System. 
 
The Server Administrator may create Export Actions for each location to which Users send files. Each of these Export 
Actions will then appear on the Client tools palette for use in constructing Workflows.  This is convenient if you wish the 
Export Action to have a name which describes what the Export is doing.  (That is, if your Export Action is sending files to 
a 3rd party RIP for proofing, you might call it “GMG Proof.”) You may also edit the export path in the client and just use 
one generic Export Action for many purposes. 
 
To create an Export Action, select the menu item Server Setup > Manage Actions. Click New Action and select 
Export from the Workflow Agent list box. Enter a suitable name and click Configure. From within the Configure 
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dialog, set the default destination location of the Export Action.  This default destination may be overridden by the client 
application. Click OK to save the settings and close the Export Action windows. 
 

5.4.6 The PrintJob Action 

This Action will, by default, take a job and convert it to one or more TIFF images and output them to the Windows Print 
Spooler and through it to a specified printer connected to the Server PC. 

  
Configuration in the Server 
Install all appropriate Windows Printer Drivers before using the PrintJob Action for output to local printers.  
The initial configuration of PrintJob Action is done in the Navigator Server. In the the New Workflow Action dialog, select 
‘Print Job’ as the Workflow Agent  and then press the‘Configure’ button. The following dialog is displayed. 

 
 

PrintJob Action Configuration 

 

 
 

 
 
 

This dialog allows you to create and edit printer configuration. One of these configurations must be selected for use when 
you configure each PrintJob Action in the Navigator Client. 

 
To make a printer configuration, first select the printer from the printer menu. The Configuration menu will be populated 
with any existing configurations for the selected printer. Select a suitable base configuration (or Default) from the 
Configuration menu. 

 
Use ‘New from Current’ to create a new configuration based on your selection, and enter a suitable name for your 
configuration. 

 
Use the Configure button to set the printing preferences for this printer. The properties dialog shown is the same as 
selecting  Printing Preferences from the printer, via the Devices and Printers control panel. 
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Direct Mode: For normal usage this option should be left unchecked; the Action will then process incoming files to TIFF 
format suitable for passing to the printer driver.  
Check this option only if you require jobs to be sent directly to the window spooler, bypassing the RIP. If this option is 
checked, the data being sent MUST be the correct format for the printer. For example, if the printer is a PostScript 
printer, PrintJob can only send PostScript files to the printer. 
 
In addition, even though PrintJob uses the Windows Printer Driver to connect to the printer, in Direct Mode  it does not 
use any of the settings for media, resolution, cassette etc. which are included in the Windows Driver setup. This is because 
these controls are bypassed by the native language files that PrintJob supports. To obtain correct output you may need to 
change default settings in the printer itself to specify the cassette, media type, quality and other options. 
 
Timeout: Enter the number of seconds the PrintJob Action should attempt to connect to the printer before reporting an 
error. 

 
The PrintJob Action Configuration dialog may also be used to edit or delete existing configurations. 
 
Configuration in the Client 
After creating one or more configuration sets in the Server, PrintJob Action must be configured in the Client. Its control 
dialog is shown below. 
 

PrintJob Action Client Configuration 

 

 
 

 
 

Select the printer, and then one of the configuration sets you made in the Server. 
 

5.5 Set System Paths 

The Server Administrator can configure the RIP Manager Server, controlling the storage location of Workflows, Job Files, 
and Archives. By default, these are sub-folders in a folder named “Navigator,” located on the “C” drive of the Navigator 
Server PC. However, the Administrator may change this to any accessible location. For better performance, Xitron 
recommends the Jobs and Workflows folders remain on the Navigator Server PC. The Archive folder may be placed on a 
remote or removable drive.  
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In addition the databases are archived, by default into a folder named “Archived DBs” within the folder containing 
Navigator Server. These archives are written every 24 hours, and are intended for manual recovery in the case of loss of 
the Navigator Server PC’s hard drive, so you may wish to set their location to a remote networked drive. If so, please 
ensure that the drive can be written with a sufficiently high transfer rate. 
 
Note: When a User creates a Workflow, the system creates a Hot Folder with the Workflow Name inside the System’s 
Jobs folder. Make sure that there is sufficient space in the designated location to store all the jobs expected to reside on the 
system at one time. Keeping several days’ or weeks’ worth of jobs on the system is possible only if sufficient drive space 
exists. 
 
To set System Paths, select the menu items Server Setup > Set Base Workflow Path, Set Base Jobs Path, Set Base 
Archive Path or Set Base Database Archive Path. In either case, the entry box below will appear. Enter the 
required path to the location you wish to use, and click OK. 
 

Set System Paths 
 

 
 

 

 
Click OK to save the settings and close the Path Configuration windows. If you have changed the Workflow or Jobs 
database locations, the Server will now shut down; restart it to make these changes effective. 
 

5.6 Server Settings 

To change the network name of a RIP Manager Server (i.e. the name that RIP Manager Client sees), select the menu item 
Server Setup > Server Settings. 
 
The system protects itself by halting job processing if the free disk space falls below a threshold level. By default this is 5 
gigabytes.  For troubleshooting purposes, you may need to change this.  In normal operation the default value is correct. 
 
The client application can set a job to delete “when necessary.”  The “when necessary” threshold is defined in terms of the 
number of jobs in the system and may be modified here. 
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Server Settings 

 
 

 

5.7 Custom Field Labels  

Navigator Workflow includes a range of features for organizing lists of jobs and related information for users. Some of the 
most powerful are the Custom Fields. These are four fields that can contain any information the user wishes. This 
information is then available for display and sorting purposes by each user from within their Clients. 
 
Defined at the Server, Custom Fields can be given appropriate names that apply system-wide. Users can then add 
information to each field on a per-job basis from any Client. 
  
To define Custom Field names, select the menu item Server Setup> Edit Custom Field Labels menu. Enter the 
Names you wish to use in the four boxes, and click OK. Name the fields any way you wish. Keep in mind that when a User 
chooses to display these fields, they will be displayed in order from left to right on the User’s screen, with Field # 1 
appearing first. 
 
In the following example, the System Administrator has chosen to allow display and job sorting on Customer name, Due 
Date, and the name of the prepress operator responsible for the job. 
 

Custom Field Labels 
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5.8 Import Files 

The Import Files dialog provides a convenient system for installing additional settings and configuration files into Navigator 
Server. The files that can be imported are Enfocus Action Lists (*.eal) and Profiles (*.ppp), and Stabilizer Document 
Parameters (*.dpf).  

5.8.1 Action Lists and Preflight Profiles  

Preflight Profiles may be created at the Server.  This process is documented below, in section 5.9.  Action Lists and 
Profiles can be created using PitStop Professional. The procedure for doing so is documented with that product. 
  

5.8.2 Stabilizer Document Parameters   

Import Stabilizer Document Parameter files the same way as Action Lists and Profiles. 
 
The PDF utility “JobOptions.exe”, found in the Navigator Server Utilities folder can be used to create Stabilizer settings 
files as shown below. 

Creating New Stabilizer Settings 

 

 
 

Select settings suitable for the purpose.  The example settings shown above might be used for commercial printing: 
 
 
 

Creating New Stabilizer Settings - cont. 
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5.9 Creating Preflight Profiles.  

Navigator has a utility built-in for creating Preflight Profiles.  They may also be created in Pitstop Professional from 
Enfocus. In the server, when you open the editor you may need to browse to the list of our built-in profiles the first time 
you use the editor.  The files are located at <Server install path> /config/PreflightProfiles. 
 
 

Select the preflight profile you would like to use as the basis for your new 
profile and click the “manage” button.  Under manage choose “New From. . .” 
and then the preflight profile editor will open with the settings from your 
selected profile.  You may then change it however you wish and save it with a 
new name.   
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5.10 Color and Name Tool – File name recognition and color recognition 

The color and name tool allows the configuration of file name analysis.  File name analysis allows Navigator Workflows to 
group files together in the same job even when they come in separately.  This is currently used for TIFF grouping for 
ROOM proofing, Ink key setting, and TIFF output.  This is covered in a separate document on the installation disk and our 
web site, called “Navigator file name analysis”.  
 

5.11 Install Script 

Some workflows can be set to process incoming files with a script instead of with workflow actions.  This script can be any 
scripting language installed on the server.  This includes Windows batch files as well as Perl, or any scripting language you 
may prefer.  There is a separate document called “Hotfolder Scripting” on the installer disk which covers this in greater 
detail.  



 

 

 Page 

34 

 
  

Chapter 6 – Configuring Network Printers 
 
Navigator Server allows users to print directly to each workflow instead of using hot folders. To do so, follow these steps: 
Go to the “Add Printer” Wizard and follow the steps as shown in the illustrations below: 
 

Step 1: Add Printer Wizard 

 

 
 
 

 

Step 2: Local Printer 
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Step 3: Create a New Port 

 
 

 
 

At step 4 shown below, when prompted to enter a port name, follow this template: <Workflows path>\<workflow 
name>\print.ps.  For example, if you wish to connect to the “DPM 2350 175lpi” workflow, your port name might be 
C:\Navigator\Workflows\DPM 2350 175lpi\print.ps. 
 

Step 4: Naming the Port 
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At step 5, click “Have Disk” and navigate to the Xitron RIP PPD, available on the install disk and at 
http://www.xitron.com/ppds.htm.  
 

Step 5: Designating the PPD 

 
 

 
 
 

 
Name your printer to indicate the workflow to which it will connect. In Step 6, we are connecting to the “Dimension425 
150lpi” workflow and have truncated the name so that OSX users can see the shared printer. 
 

Printer Naming 
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Be sure to share the printer so that everyone on the network can connect to, and use it. 
 

Printer Sharing 

 

 
 
  

These are all the steps necessary for printing with Windows and Macintosh OSX. If you wish to print from OS9 there are 
three options: 

A. Install the Server on Windows 2000/2003 Server and enable AppleTalk support  
B. Use Miramar’s PC MacLan connectivity software 
C. Configure Desktop Printer Spooling in OS9 and set up IP socket printing to the shared Windows Printer. For 

more information about this option, see Xitron Tech Bulletin TB04-003, “Using LPR or IP Printing from OS9 
and OS X”, at http://www.xitron.com/support/technical-documents/navigator-bulletins-2004/

http://www.xitron.com/tb2004.htm
http://www.xitron.com/support/technical-documents/navigator-bulletins-2004/


 

 
 

Chapter 7 – Client Installation 
 

7.1 Introduction 

Navigator installs from a dual-mode disk which will function on both PC and Macintosh computers. On PCs, the disk is 
capable of installing Navigator Server and Navigator Clients. On Macintosh computers, it will install only the Navigator 
Client. As mentioned earlier, Navigator Server will not run under the Mac OS. 

7.2 Installing an Upgrade 

Installing Navigator Server to an existing Navigator Server or RIP Manager installation folder is a perfectly acceptable 
upgrade method.  See Appendix B. 
  
Note: If you upgrade one part of the system you must upgrade all parts for correct operation. If you upgrade your Server 
you must also upgrade all Clients before running the system. 

7.3 Installing the PC Client 

Begin by inserting the Navigator disk into your PC’s DVD drive. The install window below will appear: 
 

PC Installer Window 

 

 
 

To install the Navigator Client on this PC, click the Client button, and then click Next.The installer will prompt you for 
an install location. During the install process, it will place a shortcut icon on the desktop that you may use to launch the 
Client, or you may launch it from the Start menu. 
 
After installation of the client application on any computer you may need to mount the Jobs and Workflows volumes. 
The installer automatically created these volumes and set them up for sharing. Navigator will automatically mount these, as 
needed. If you wish to turn off auto-mounting of shares, do so from the Navigator preferences menu in the Client 
software. 
 
To manually attach the shares from a Windows PC, open any window and type \\<machine name>. After you enter 
any required password, the window will display shares. Right-click on the Jobs volume and choose Map Network 
Drive. Repeat the process for Workflows. An example appears on page 30.  
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Manually Attaching Shares 

 

 

 
 

7.4 Installing the Mac Client 

To install the Client on OS X, open the disk image file in the Mac client folder on the CD.  At that point you may drag the 
application to the “applications folder”.   A link to the “applications” folder is provided by our installer disk image.  (See 
below) You may want to put a copy of the Navigator Client application in your Dock. 
 

Mac Client Installer 
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Note: Remember that OSX Macs are able to mount folders shared by Windows. Navigator will automatically mount these 
as needed. If you wish to turn off auto-mounting of shares, do so from the preferences menu in the Client software. 
 
To manually attach the shares from a Macintosh: Through Finder, navigate to the “Go” menu and choose Connect to 
Server. Type smb://<machine name>/Jobs.  Repeat the process for “Workflows.” The following example 
illustrates the dialog box. 
 

Mounting Shares on OSX 

 

 
 

 
 



 

 
 

Chapter 8 – Client Tutorial 

8.1 Introduction 

Once the Navigator Server has been set up, the Client can handle all Navigator operations. This Chapter describes how to 
use the Client for the most common of these operations. It is based on the PC Client, but the Mac version has the same 
appearance and features. Any significant differences in controls are mentioned in the following text.  
 
This Chapter is written as a Tutorial. It will guide the User though construction of a simple but useful “Proof, Hold and 
Output” workflow arrangement, while covering most of the features of the Navigator Client. A detailed list of the controls 
and their functions is available in Chapter 5 – Navigator Client Detail.  
 
One of the key features of Navigator is the ability of Client users to build workflows using any pre-defined Page Setup on 
their RIP. This provides a useful separation from basic “house” setup (resolutions, screen rulings etc.) and the handling of 
particular jobs. In this chapter we make use of two RIP page setups, one for proofing and one for separated, high-
resolution platesetter output. To follow this tutorial you will need to select two page setups that are available on your RIP, 
or create dummy setups for the exercise. 
 
What follows is a typical view of the Navigator Client Graphical User Interface (GUI): 
 

Client GUI 

 

 
 

 
The GUI has a number of regions, noted here starting from the top: 
 

 Menu Bar – Control menus 

 Tool Bar – Displays icons of frequently used controls 
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 (Left window panel) Workflow or Workflow Component “picking” area. 

 (Top right window panel) Current Workflow Diagram 

 (Lower right window panel) Job List 

 Status Bar 
 
Functionality of these areas will vary according to context, but the general layout remains the same. 
 
There are several steps to creating and using Workflows within Navigator, which will be reviewed in sequence. Not all 
users have to know all the details of workflow creation. For example, Users can manage workflows created by others 
without having to learn how to create or modify workflows themselves. Also, the Administrator may limit the permission 
of users to make changes. If one or more of the controls discussed in this chapter appear “grayed out,” or not useable in the 
Navigator Client, it may be necessary to verify the User permission settings with the Administrator. 

8.2 Logging In 

After launching the Client application, the following window appears: 
 

Log-In Window 

 

 
 

 

8.2.1 Locate the Server 

The Client will search the Network for Navigator servers, displaying all that it finds in the Server list box. If you cannot see 
your server, verify that it is running before clicking the Find Servers button. The system will also accept entry of the 
specific Server name or the IP Address of the Server platform using the Add Server dialog. 

8.2.2 User Name 

Enter your User Name and password, if any. In Navigator, user names and passwords are case sensitive. The computer will 
remember your password after activating the Remember Password box. Similarly, the Client will automatically log in 
to the server during the next launch after activating the Automatic Log In box. Note: Activating either of these check 
boxes will allow others to use the Navigator Client in the future without supplying a username or password. 
 
Click OK and the Client will attempt to Log In to the Server.  

8.3 Creating Workflows 

During the first login, if there are no jobs or Workflows in the System, an empty dialog will appear. Therefore, the first 
necessary step is the creation of a workflow by going to the Workflows > New Workflow menu selection. The view 
will change to the Workflow Edit view, and the New Workflow dialog appears.  
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(You can also change to the Workflow Edit view at any time by using the icon in the Tool Bar). 
 
Enter a Workflow name in the New Workflow Name dialog and click OK. In this example, the first workflow name is 
“Proof – Epson 7880”. 
 

New Workflow: Proof – Epson 7880 

 
 
 

 
 

 
In the Workflow panel on the left side of the GUI are tabbed areas displaying all the Workflow Actions previously created 
at the Server.  A new Workflow starts with just an input Hot Folder in the Workflow Diagram area. Select the RIP tab and 
use the mouse to click and drag the RIP Action icon onto the Workflow Diagram. Release the mouse button and the 
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system will add the RIP Action icon to the Workflow Diagram. Next, select the Output tab and drag the RIP Output icon 
onto the Workflow Diagram. These will combine into the basic Workflow shown above. 
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8.3.1 General Workflow Configuration 

Each workflow is configurable through the tabbed menus in the lower portion of the GUI. Under the General tab are the 
following controls: 
 
Workflow Name - changes the name of the selected workflow. 
Priority - applied to jobs processed through this Workflow. If there are other Workflows competing for the same 
resource, as is usually the case, then Normal priority jobs are processed in the order in which they arrive. High priority 
jobs are processed ahead of any Normal priority jobs and Low priority jobs are only processed when there are no other 
jobs waiting on the System. 
Get Ahead - controls how many jobs the system will schedule at one time for a processing Action. The default value is 5 
jobs. This should be changed when load balancing.  
Send To Workflow - allows completed jobs to be sent to another workflow. This is a common way of linking 
workflows.  Note that Send To Workflow sends the original job file. To copy an intermediate file such as a PDF file 
created by the Stabilizer to another workflow, use the Copy Action. 
Archive - places jobs in the Archive folder when deleted from the Workflow. 
Delete - instructs the system when to delete jobs. Selecting When Necessary instructs the system to delete the oldest 
jobs in the system when it reaches a default limit of 250 jobs. 
 
Accept the default settings in the General tab for the moment, and select the Hot Folder tab by clicking on the tab itself 
or by clicking on the Hot Folder Icon in the Workflow Diagram. 
 

Hot Folder Configuration 

 

 
 

8.3.2 Hot Folder Configuration 

The following controls are available for configuration of Hot Folders: 
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Input Folder - This selection is preset to the default job location defined in the Navigator Server setup. To change the 
Hot Folder location, use the Browse button.  Remember that you are browsing from the location where the Navigator 
Server is installed, not your own workstation.  
Use Color and Name Recognition – groups multiple TIFF files together as one job. Use with an appropriate 
configuration file from the Server’s Color and Name Tool. 
Process Files using Script – processes input files with a script.  Use in workflows consisting of a hotfolder only.  Install 
scripts with the Server command “Install Script”.  See separate scripting manual for more detail. 
Job Name - Several controls allow you to define how the system will name jobs during processing. 
 

The System Job Name (the name displayed in the Navigator Client) may contain up to three parts. Each part is 
set by the three columns of radio-buttons. To construct the Job Name, click on one button from each column. 
The functions of the buttons are: 
 Job Title –Original document name extracted from the postscript or PDF. 
 File Name – name of the file that contains the job 

Date and Time – current date and time when the job was accepted into the system 
Job Number –sequential job number 
Edit Box – any arbitrary text 
None – no entry for this part of the name. 

 
Make the selections shown in the illustration on the previous page (or use your own name if you choose). In the 
example, jobs will be named “Elmo– Title from Job file – Date & Time.” 

 
Hold After – Activating this check box causes all jobs to enter a hold state after processing. The jobs are then manually 
released or sent to another workflow. Note that selecting this option causes a red circle to appear on the Workflow 
diagram to indicate the Hold function is active.  
 
Next, configure the RIP Action. Go to the RIP Action by clicking on the tab or on the RIP Action icon in the Workflow 
Diagram. 
 

RIP Action Configuration 
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8.3.3 Configuring the RIP Action 

There are several controls in the RIP Action configuration dialog: 
 
Page Setup – This list box shows all the Page Setups available on the selected RIP. Choose the Page Setup for this 
Workflow to use. In this example, since this is a Proofing workflow, “Epson 4800” was chosen. 
Pause After – Causes all jobs to enter a Held state after RIPing, but before output. The jobs are then released manually. 
Activate this function for the purpose of this example. 
Refresh Page Setups – Selecting this function forces Navigator to request a new list of Page Setups from the RIP. This is 
helpful after creating a new Page Setup that did not appear in an earlier list. 
Page setup configuration:  Below the top three controls is a listing of the configuration of your chosen RIP Page Setup.  
You can override several of these settings from the client either globally or on a job-by-job basis. 
Font Emulation:  If this control is checked, substitute fonts will be used where possible, to replace any missing fonts in 
the job. This is often preferable to a job being rejected, for instance in the rapid turnaround workflows typical of digital 
printing. If a font is missing, the RIP will attempt to find the correct font in the job, or installed in the RIP; it will then 
look for a substitute font already defined in the RIP. Only if none of those are possible will it attempt to emulate missing 
fonts. This strategy is taken to achieve the closest match possible for any missing fonts. 
Abort Job on Missing Font:  If this control is checked, any job which would otherwise be rendered with one or  
more missing fonts will be aborted. If Font Emulation is enabled, the RIP will instead emulate missing fonts if possible. If  
this control is not checked, any missing fonts which cannot be substituted (or emulated, if this option is on) will be  
replaced with Courier. 
 
This completes the basic Workflow setup.   RIP Output has no configurable controls except in a few special cases.  These 
cases are covered in related plug-in manuals. 
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Chapter 9: Workflow Configuration Examples  

9.1 Primary Workflows  

Your main workflows will contain everything you need to follow your job through the system. They may use secondary 
workflows to accomplish desired actions, such as proofing, but all of the stages can be tracked from the main, or primary, 
workflow. Following are examples of two primary workflows. 
 
The workflow labeled ”CTP Output”  contains an input method, followed by a connection to a proofing system, a pause, a 
connection to the RIP Page Setup for a CTP device, a pause, and finally, output to the platesetter.  The Page Setup chosen, 
created in the RIP, will be listed above the HQN RIP Action icon. All of these steps are controlled within this particular 
workflow except for the proofing. The proofing is controlled in a secondary workflow or sub-workflow.  We will discuss 
sub-workflows later in this chapter.  (This is for example.  Proofing may also be accomplished in the same workflow using 
the Direct Output Action) 
 

Example CTP Workflow 

 

 
 

“Full CTP Workflow” contains additional actions.  The two additional actions constitute a  
PDF workflow and provide for PDF conversion, problem reporting, and automated problem resolution.  
 

Example CTP Workflow 
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Each pause in the workflow indicates a point where the job will go on hold, indicated with a yellow pause icon in the job 
list, awaiting user intervention. These pauses are optional after any workflow action.  
Each of the primary workflows shown requests a proof from the secondary workflow “Proof – Epson 7880” and the file is 
processed according to that workflow’s configuration.  In these examples, this request is accomplished with a Copy Action 
named “Proof.”   After this, the job goes on hold at the Proof stage and waits for the job approval to come back.  When this 
occurs, the user will manually release the job to the next stage. This is the RIP and Trap stage.  After RIP and Trap there 
could be a final pause, allowing any client user to preview the screened data before releasing it to the 
imagesetter/platesetter.  
 

9.2 Secondary Workflows  

The secondary workflow takes over when the primary workflow’s main intent is to control the main output device. One of 
the identifying characteristics of a secondary workflow is the Delete Always setting.  This indicates that the Primary 
workflow will track and keep the job. The secondary workflow simply carries out its commands but does not keep any 
copies of the job.   A Hold After this stage in the Primary workflow is necessary for job tracking purposes.  If you have a 
hold, then while the proof workflow has the job, the job will show its status in the primary workflow as Hold – Proof. In 
the case of Proof – Epson, the proof is a Harlequin RIP plug-in driving an Epson proofer. This workflow simply delivers 
the job to the correct page setup in the RIP.  

Secondary Workflow Example 
 
 

 
 

 
 



  

 

 Page 

50 

 
  

 

 

9.3 Alternative Proofing 

Many users will want to proof with the same RIP they use to make their film or plates.  A proofer plug-in, such as Xitron’s 
vDot II, directly supports many inkjet proofers. Users with different proofing needs will find automated support for them 
in Navigator. 
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9.3.1 Proofing to another RIP   
To send jobs to a third-party RIP from within a workflow, set up an Export Action at the Navigator Server. This will send 
to a networked spool folder for the other RIP.  Name the Export Action after that RIP or after the device the RIP drives. 
Set up a workflow that looks like the following example: 
 

Third-Party RIP Export 
 

 

9.3.2 RIPed TIFF proofs  

There are two ways to configure the system for using the same RIP for proofing and final output. You can purchase a 
proofing plug-in for that RIP (See the workflow Proof – Epson) or you can RIP the file as a composite or 1-bit TIFF and 
deliver it to a proofing RIP that accepts these files via spool folder. For a TIFF proof, you must set up a TIFF device page 
setup in the RIP that outputs to the spool folder of the proofing RIP.  The workflow will look just like the Epson proof 
workflow. The only difference is the output device chosen in the Page Setup. 

9.3.3 Raster PDF files for email or Web proofing.  

Use the Raster PDF soft proofing plug-in as the output device in your Page Setup.  This will provide a RIPed and, if 
desired, screened PDF file suitable for soft proofing.   
 

9.3.4 Sending to networked PostScript printers.  

The PrintJob Action, by default, simply a TIFF version of the job to whichever Windows printer you select. As long as the 
job size is appropriate for the paper and you are using PostScript files this can be useful. Set up a PrintJob Action in the 
Server, and then set up a workflow that looks like the one labeled Proof-Laser below. 
 

Sending to Networked Printers 
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9.4 Multiple RIP Workflows 

To bring additional RIPs into Navigator Server’s control, add them in the Navigator Server under Manage Workflow 
Actions.  Each RIP to be controlled by must be configured with the RIP Utilities install.  Insert your installation CD 
into the RIP computer and choose Navigator Server.  At the next screen, choose the RIP Utilities install. This install 
will make the RIP available to Navigator Server.  
 
Go to Manage Workflow Actions and add another HQN RIP v7 action.  See section 3.4.1 for help configuring the RIP 
Action. In the client you will now have one RIP for every HQN RIP action configured in your server. Make a new 
workflow and call it “Load Balancing”. Drag over two RIPs and two RIP Outputs. The workflow will look like the example 
shown below. 
 

Multiple RIP Workflow Example 
 

 
 

Set the “Get Ahead” number to zero for a load balancing workflow or leave it at the default setting for a standard 
workflow. 
 

Setting the Get Ahead Numbers 
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Jobs sent to the load balancing workflow will alternate between idle RIPs.  When the RIPs are not idle, Navigator Server 
will send the next job to the first RIP available. 
 

Chapter10: Using the Client  

At this point you should have created some workflows and submitted some jobs.  Click on the Job View icon to 
display a list of jobs in the System. 
 
We can simulate receiving a job in the system using the File > New Job menu selection. When you choose New Job the 
following dialog appears: 
 

New Job Selector 
 

 
  
 

  



  

 

 Page 

54 

 
  

To send a job to a particular workflow, select it in the Workflow list box, choose a suitable file and click Open. (You can 
also drag-and-drop a file onto the appropriate workflow icon on the left of the Job Views dialog.) 
 
The job will then appear in the Workflow. The colored symbol to the left of the job will change from Green 
(Busy/Processing) to yellow (Held). If the symbol turns Red (error), there is a problem processing the file.  Error 
messages accompanying the error state will help determine the cause. 

10.1. Sending jobs to Navigator Server 

There are many ways to send jobs through Navigator Server for processing. The most convenient will depend on the type 
of work you do, the platforms you use, and your own preferences. 

10.1.2 Drag and Drop 

If you have, or create from your application and print driver, a PostScript or PDF file of your job, the easiest way to submit 
it to a Workflow is to drag it onto the client window. You can either drop the job on one of the workflows on the left side 
of the screen, or onto the large workflow image at the top of the screen. Both have the same effect. The system will place 
the job in the designated Hot Folder and the workflow will process it as if it had arrived in the Hot Folder from elsewhere. 
 

10.1.3 Through AppleTalk 

If you have installed PC MacLan on the Server and set up an AppleTalk Printer folder as one of your Workflow Hot 
Folders, you can print directly to this Printer from any OS9 computer via the Chooser. PC MacLan will receive and store 
the file before Navigator processes it. 

10.1.4 From an OS X Mac 

You can use any of the methods discussed here to send jobs from an OS X based Mac. You may print to a shared Windows 
printer, as discussed below, and you can also save a PDF file directly from the Application into a workflow Hot Folder. 
You can save the file directly into the workflow hot folder on the Server or place it on your desktop and drag it onto the 
Navigator client. 

10.1.5 From a Windows Application 

You can print directly from a PC application provided you install suitable PostScript printer driver software. Xitron 
recommends using the Adobe PS 5.0 or later driver, which is available free of charge from the Adobe Web site. To 
configure this driver for output directly to a Navigator Workflow, follow the steps below. 
 
Note: Automatic file naming causes all jobs to be printed without user interaction, but all jobs will have the same file 
name. This is normally not a problem since Navigator Server will collect the jobs and move them much more quickly than 
the application is likely to print new jobs (and thus overwrite the first job). However if you wish to print multiple jobs 
when Navigator Server is not running, you will need to use the Manual file naming method. 

10.1.5.1 With Automatic File Naming 

Locate the Printer Driver in your Printers folder as shown below. 
 

Printers Folder Example 
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 Right-click, select Properties and go to the Ports tab. Click Add Port, then Local Port, then New Port. You will 
see the dialog shown in the figure at the top of the next page labeled, Add New Local Port 
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Add New Local Port 
 

 
 
 

 
Enter the full path for the Navigator Server hot folder location you wish to use, including a file name. You can use any 
name, such as “print.ps” as shown below. 
 

Port Name 

 
 

 
After clicking OK, the system will check for the existence of the specified folder. If it can’t find it, check the spelling and 
drive letter before trying again. Click OK and close the various dialogs. If you now choose this printer from any PC 
application and print a job to it, the system will write the job as a PostScript file called “print.ps” in the Navigator Server 

hot folder you have selected.  

10.1.6.2 Manual File Naming 

Proceed as above, locating your printer driver. Right-click, select Properties, and go to the Ports tab. Select the FILE: 
option from the list box. Click OK to close the dialog. 
 
Now when you print to this printer driver, Windows will prompt you for the location and name of the file. Browse to the 
Navigator Server hot folder, type any filename and click OK. 

10.1.7 Using the New Job Menu Command 

Within the client, selecting New Job from the File menu allows you to choose a Workflow and then browse for any file 
that is accessible from your computer. Selecting this file and clicking Open will copy this file into the workflow hot folder. 
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Now you should be able to get jobs into the system.  After submitting and processing 16 jobs, the Jobs View looks similar 
to the following example. 
 

 Jobs View 
  

 
 

10.2 Custom Column Displays 

Look carefully at the example labeled, Jobs View and compare it with your Client. You will notice that the two columns 
on the right side, Custom 1 and Custom 2, do not appear on your copy of the Client. These columns are part of the 
optional job information fields system, and will not appear until properly configured. 
 
These are system-wide field naming and Client display options and there are two steps to configuring them. See the Server 
configuration chapter above for system-wide naming of the custom fields at the Navigator Server. If you have not 
configured your custom fields, this is a good time to go back to the Server and make these changes. Once you have 
configured the custom fields, return to the Client and choose the Jobs > Column Headings menu selection, which 
appears on the following page. 
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Client Column Displays 
 
 

 
 

The top 6 choices are standard on all systems, and of these, the system will always display Job Name. The bottom four 
choices are the Custom Fields and the names seen here are the names you have defined in the Navigator Server. Simply 
check the box for each column that you wish the system to display. Columns are arranged in order from left to right as the 
list reads top to bottom. For all columns displayed you can order the jobs by clicking on the column header. Clicking once 
will sort the jobs in ascending order and clicking again will re-sort in descending order.  
 
If you change the Custom Column Displays to match the example labeled Client Column Displays, you will see the 
same arrangement in your client as previously shown in the example Jobs View. 

10.2.1 Setting Column Widths 

The widths of the displayed columns are variable. Adjust them at any time by clicking and holding on the boundary 
between any two column headings and moving left or right. Click over the boundary between the Job Name and Job 
Number column headings and extend the width of the Job Name column to display the full name as shown below. 
 

Column Widths 

 
 

 
Notice that the system follows the rules for Job Naming defined during configuration of the Hot Folders within the 
AppleTalk and Receive & Proof workflows. 
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Note: A change to the Job Naming rules for these Workflows at this point will not change the Names of jobs already in the 
system. Changes will affect all new jobs coming into the system after the change is made. Additionally, editing workflows 
will stop the processing of jobs until the changes are complete and the Client returns to the Jobs View (at the time the 
Workflow is re-started).  
 
Return to the Jobs > Column Headings menu selection, uncheck the Job Number box and click OK. The system no 
longer displays the Job Number column, leaving more room for the expanded Job Name column. 

10.2.2 Entering Custom Data 

Now that configuration of Custom Information is complete, the next step is to enter data into these fields. Data can be 
entered at any time that a job is Held, and this is the reason the Receive & Proof Workflow has a Hold set at the input Hot 
Folder stage. All three jobs in the list are now On Hold. 
 
Highlight each of the sample jobs in turn. For each job, choose the Jobs > Get Info menu selection. (Access the same 

function by highlighting the job, right-clicking and choosing Get Info, or clicking the Job Info  button.) 
 

Job Information 
 

 
 

There are four edit boxes in the center of the dialog. These will be labeled with the same names used when defining the 
Custom Fields in the Navigator Server configuration - and also the same names that appear in the Column Headings dialog. 
Enter suitable information for Customer, Due Date, and Operator.  

10.3 Sorting Job Lists 
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In the Jobs View window, experiment by clicking the various column headings; Job Name, Job Number, Client (custom), 
Deadline (custom), etc. This will sort the list of jobs in either forward or reverse order based on the contents of the 
column. 
 
In practice, the system will sort data by whatever information appears in the standard columns or custom columns. The 
naming convention used in the Hot Folder configuration also affects sorting. If, for example, Date and Time is set as the 
first part of the Job Name, you will be able to sort jobs by the date and time they arrive within the workflow. 

10.4 Releasing Held Jobs 

There are many reasons to hold jobs at different stages of the workflow; adding job information as illustrated above is just 
one example. Once all necessary tasks for a held job are complete, the job will have to be released if further processing is 
to take place.   
 
To release a job to the next step in its workflow, highlight the job, right-click and select Release to Next Step. 
Alternatively, use the Jobs > Release to Next Step menu selection or click the Release to Next Step button. 
 

10.5 Viewing Jobs by Workflow & Status 

The Navigator Client has several ways of presenting information about jobs in the system. 
From the Jobs View, clicking on one of the Workflow icons to the left will change the window to reflect that Workflow’s 
diagram, plus a list of only those jobs that are in the System under that workflow. 
 

Jobs View 
 

 
 
 

As an example, clicking (once) on the CTP Output workflow icon shown above will change the view to the example at the 
top of page 49. 
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Selected Workflow View 
 

 
 
 

Similarly: 

 The  Held button will display all jobs that are paused, in all Workflows. 
 

 The  Completed button will display all jobs completed, in all Workflows. 
 
These tools, combined with the column sorting options, allow quick management of a large number of jobs without the 
effort of searching through job lists. 
 

10.6 Viewing Jobs by Search Field Delimiters 

The client can be limited to show only jobs assigned to a particular prepress operator, or customer, or due date, or 
anything keyed into a custom field.  The search field can also search for job title or error state.  
 
The examples on page 50 show the jobs list before any search was entered and the same jobs list after a search was entered. 
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Jobs List Before Search 
 

 
 
 

 

Jobs List After Search 
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10.7 Previewing Jobs 

The Navigator includes an integrated Viewer to preview jobs after RIPing and before output. This section will illustrate the 
preview of both composite color images intended for proofing and separated, screened images intended for final output. 
 

Return to the All Jobs  view. Locate or create a job that has been run and held. Double-click on the job (or click 
on the plus symbol) to expand the job “tree.” Repeat this process on each folder revealed until the whole tree has been 
expanded. If the job was a four-color job and was allowed to process past the first hold in the CTP Output Workflow, it 
should look similar to the job shown below 
 

Expanded Job Tree with Composite PGB 
 

 
 

Under the folders you will see two files. The original job file with a “.ps” (PostScript) extension and the RIP Page Buffer 
file (PGB). The PGB file is identifiable by its location within the RIP folder because only Page Buffer files can appear here. 
The fact that there is only one PGB file for the job and that it has a multicolored icon as shown above tells us that this is a 
Composite Page Buffer.  

Highlight the PGB file, right-click and select View PGB; or click on the  Preview button; or double-click the 
PGB file. 
 
The Viewer will launch and details of the PGB file appear in the lower right panel labeled, “Info.” (See Appendix A for 
complete details about the Viewer.) Select the Navigator tab to see a thumbnail view of the page. Click on the image and 
the main panel will shift to a 100% scale view of the same area. Zoom in and out by selecting the + and – buttons and 
double-clicking on the image, or by selecting a resolution from the list. Pan the image by holding down the mouse button 
on the image and moving the mouse around. 
 
The Preview will be similar to the example shown on page 52. 
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Preview Image 

 
 

 
 

 
Use the Preview to check the job for proper orientation, fonts, dimensions, etc., before releasing it to the next stage 
(provided the Workflow is set to Hold in the RIP Action Configuration tab). Close the Preview window and return to the 
Job View in the Navigator Client. 
 
This time expand one of the jobs with an orange triangle in the Hi Res Workflow. 
 
Because these are separated Page Buffers, the expanded tree will look like the example below. 
 

Expanded Job Tree with Separated PGBs 
 

 
 

Again highlight one of these PGBs and select the  Preview button. 
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With a file created for final output to an imagesetter or platesetter, the preview image will show the screening used during 
the RIPing process. It is also possible to display individual colors or combinations to review traps, knockouts and 
overprints. 

Preview with Screened Image 
 
 

 
 

 

For more details on the viewer see Appendix A. 
 

10.8 Final Output 

After approving the job based on the preview image, output the separations to the plate or film device by right-clicking the 
job and selecting Release to next step. 

10.9 Deleting & Archiving Jobs 

To delete jobs from the system, highlight them (select a group of jobs together using the mouse and the shift or Ctrl. key 
on the PC, or holding the mouse button and dragging the mouse over the files on the Mac). You can then either right-click 
and choose Delete or use the Jobs menu to access the Delete selection. Also, after highlighting you may delete jobs by 
using the Delete key on the keyboard, or the Delete Jobs button in the client window. 
 
Earlier, we activated the Archive check box in the General tab of the High Res Workflow. Therefore, after deleting jobs 
from this Workflow, the system automatically archived them. To retrieve these jobs, path to the System Archive location 
set during Navigator Server configuration.  Within the Archive folder, Navigator creates dated folders for each month that 
jobs were archived. Within each monthly folder are dated folders for each day. Jobs archived today will be in a folder 
labeled with today’s date. Re-introduce these jobs to Navigator by using the File > New Job menu selection and fetch the 
job from the Archive folder. 
 
Note: The system archives the original files (PostScript, PDF), pre-flighted files and other intermediate steps. The system 
does NOT archive the RIPed page buffer files. 





 

 
 

Chapter 11 – The Navigator Client in Detail 

11.1 Menu Bar Items 

11.1.1 The File Menu 

 
The File menu contains the following items: 
 

New Job 
This selection opens the New Job Window for associating files with a workflow and importing jobs for 
processing. When using this method to submit jobs, choose the job for processing and the workflow that 
will process it. 
 

Login 
This selection allows a user to log into the Server. It is only an option when there is no user already 
logged in to the system.  
 

Logout 
This selection allows a user to log out of the Server. It is only available if a user is logged in. 
 

User Info 
This selection opens a dialogue supplying the following information about the current user: User Name, 
User Rights / Permissions, Name of the Server to which the Client is connected. 
 

Reset Preferences 
This selection resets Client Preferences to factory defaults.  
 

Exit 
Selecting Exit closes the Client. 

 

11.1.2 The Jobs Menu 

 
The Jobs menu contains the following items: 
 
Note: The items listed below are only valid in relation to a Job within the Workflow. They will only become available after 
highlighting (selecting) a job in the Client Job List. 

 
 
Get Info 

This selection opens the Job Information Window.  

 This function is also available by right-clicking on a job and choosing Get Info from the pop-up 

menu, or by clicking the Get Info  button on the Tool Bar. 
The Job Information Window provides an overview of the job. It can be used to change the job name 
reported in Navigator Client and enter data into the Custom Fields. Other information displayed 
includes Job Status, the Workflow name where the job resides and a log of the job’s progress through the 
system. 

 
Flag 
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This marks a job so that it may not be deleted.  In order to delete a flagged job, it must first be “un-
flagged.”  This may be useful for repeat work. 
 
 

Delete 
Selecting Delete after highlighting a job will cause the system to delete the selected file. Use delete to 
remove any job or sub-file within a job.  
 
For example, it is possible to use delete to remove an unwanted PGB (RIPed page or separation) file, or 
an unwanted color at the last minute before sending the job to output. Note: Deleting a sub file will 
remove it from the system entirely. 
 

 Delete will only be available after highlighting an appropriate file in the Job List. 

 This function is also accessible by right-clicking on a job and choosing Delete from the pop-up 
menu or by clicking the Delete Button on the Tool Bar. 

 
Edit Workflow for This Job  

This will put the Navigator Client in Edit Workflow mode for making changes to the workflow of the 
selected job ONLY. (On the Mac client, this reads Edit Workflow) 
 

 This function is also accessible by right-clicking on a job and choosing Edit Workflow for this 
Job from the pop-up menu. 

 
This is a powerful tool that allows changes to the workflow settings only of a specific job. For example, if 
a job errors when sent as a PostScript file, running it through the Stabilizer to create a PDF file may 
allow it to run. Using this option, a user can add a Stabilization Action to the workflow of the selected 
job. By releasing only the file in the “Hot Folder” to the next step, the system will re-process the job, this 
time with a Stabilization Action. Similarly, if a PDF job errors, a user can add a Preflight Action to the 
selected job’s Workflow without having to create an entirely new Workflow to perform the specialized 
Preflight task required.  
 

 
Pause Job 

Choosing this selection will cause the system to pause processing of the selected job.  
 

 This function will only be available if the selected job status is such that a pause is a logical step. For 
instance, Pause Job will not be available if the Job’s Status shows Completed. 
 

 This function is also accessible by right-clicking on a job and choosing Pause Job from the pop-up 
menu. 

Copy  
This menu item will open a list of established Workflows in the system. Choosing one of the Workflows 
listed will cause the system to process a copy of the job using the selected workflow. The original Job 
remains unchanged. 
 

 This function is also accessible by right-clicking on a job and choosing Copy from the pop-up menu 
or by clicking the Copy Button on the Tool Bar. Using the PC client, a user can also drag and drop 
the job while holding down the Control Key. Using a Mac, the same function is available using the 
Option Key. 
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Restart Job  
This menu item will open a list of established Workflows in the system. Choosing one of the Workflows 
listed will cause the selected job to restart from the beginning, using the original input file, through the 
new Workflow selected. 
 

 This function is also accessible by right-clicking on a job and choosing Restart Job from the pop-up 
menu or by clicking the Restart Job Button on the Tool Bar. In addition, simply dragging the job 
onto a new Workflow will have the same effect. 

 
Release to next step 

This selection releases the selected job from a Hold or Pause Status to the next process specified in the 
Job’s Workflow.  
 
 This function is also accessible by right-clicking on a job and choosing Release to next step from the 

pop-up menu or by clicking the Release to next step Button on the Tool Bar. 

 
 

Send selected file to next step 
Releases the selected file from within a job – an individual PS/PDF/PGB (a RIPed page or separation) – 
file to the next process specified in the Job’s Workflow.  
 
For example, if it is necessary to release only one of the pages or separations of a job to the Output 
Action for imaging, it is possible to highlight the desired page or separation and, by choosing Send 
selected file to next step, only release that separation or page for output. 
 

 Send selected file to next step will only be available after highlighting an appropriate file in the 
Job List. 

 This function is also accessible by right-clicking on a job and choosing Send selected file to next 
step from the pop-up menu. 

 
Set Priority 

This menu item will open a list of Job Priority settings (Low, Normal and High). Choosing one of these 
priority settings will change the priority for the selected job.  
 

 This function is also accessible by selecting the job, right-clicking and choosing Select Priority. 
 
Open File 

Choosing this menu item will open the selected file in the proper editing/viewing program. For 
example, after highlighting a PDF file and selecting Open File the PDF file will open in Adobe Acrobat 
for review and editing, provided Acrobat is available on the system. Similarly, The Viewer will launch 
after highlighting a PGB file (a RIPed page or separation) and selecting Open File.  
 

 Open File will only be available after selecting an editable or viewable file type in the Job List 
window. 

 This function is also accessible by right-clicking on a job and choosing Open File from the pop-up 
menu, by clicking the Open File Button on the Tool Bar, or double-clicking on the PGB or PDF 
file. (PDF files will only open if you have Adobe Acrobat or Acrobat Reader installed on the 
system.)  

 
See Appendix A for a description of the Viewer and Viewer functionality. 



 

 

 Page 

70 

 
  

 
The following two items are for configuration preferences and are not job related. They are available at all times. 

 
Column Headings 

This selection opens a dialogue allowing the user to turn on and off the column headings that display job 
information in the Job List Window Panel. 
 
 

Viewer Properties 
This menu selection opens a window allowing the user to adjust Viewer settings such as disk usage, 
memory allocation and initial down-sample sizes. See Appendix A, Section A.2 for details. 
 
 
 

11.1.3 The Workflows Menu 

 
New Workflow 

This menu selection begins the process of creating a new workflow. 
 

Cancel Any Changes 
Cancels all changes made in creating or editing Workflows during the current editing session. This 
option will be grayed out (unavailable) if the user is not in Workflow Edit Mode. 
 
Note: If you leave the Workflow Editing mode by changing to a Job View mode, all changes made 
during Workflow Editing are automatically saved and applied to all future jobs. 

 
Copy Workflow 

This selection opens a sub menu listing all of the Established Workflows in the the system. Choosing one 
of the listed Workflows will copy its parameters to a new Workflow. The user must provide a new name 
for the copied Workflow. After copying and naming a Workflow it will immediately be available for 
editing. This function is also accessible by right-clicking on a workflow icon in the Left Window Pane 
(Workflow list) and selecting Copy Workflow (Control-click on a Macintosh). 

 
Edit Workflow 

This selection opens a sub-menu listing all of the Established Workflows in the the system. Choosing one 
of the listed Workflows will allow editing of the parameters for that workflow. The system will save 
changes when exiting Workflow Edit mode using the “Edit workflow Icon” in the Tool Bar or by 
changing from the Workflow Edit mode to a Job View mode. This function is also accessible by right-
clicking on a workflow, and selecting Edit Workflow (Control-click on a Macintosh), or double-
clicking on the Workflow name. 
 

11.1.4 The Help Menu 

 
About  

Selecting this displays the release version and Copyright information for the Navigator Client. 
 
 

11.2 Tool Bar Items 
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The tool bar uses graphic buttons to represent the most commonly used Navigator Client functions. From left to right, the 
three sections are; Job View, Workflow Edit, and Job Management. 
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11.2.1 Job View Section 

 
The View All Jobs Button: 

 

   
 
Clicking this button will place the Client in Job View Mode. The left panel of the Client window will 
display icons for each of the established Workflows. The right panel of the Client window will display a 
list of all jobs in the system. 

 
The View Held Jobs Button: 

 

 
 
Clicking this button will place the Client in Job View Mode, but will only show those jobs that are on 
hold. The left panel of the Client window will display icons for each of the established Workflows. The 
right panel of the Client window will display a list of all held jobs in the system. 
 

The View Completed Jobs Button: 
 

 
 
Clicking this button will place the Client in Job View Mode, but will only show completed jobs. The left 
panel of the Client window will display icons for each of the established Workflows. The right panel of 
the Client window will display a list of all completed jobs in the system. 
 

11.2.2 Workflow Edit Section 

 
The Edit Workflow Button: 

 

 
 
Clicking this button will put the Client into Edit Workflow mode. (Or, if you are already in Edit 
Workflow mode it will return you to Jobs View mode.) The currently selected or last selected 
Workflow will be the one the system opens for editing. This function is also accessible by right-clicking 
on a workflow, and selecting Edit Workflow (Control-click on a Macintosh). 
 
The left window panel in client will display a list of Available Workflow Components called Actions. 
The upper right window panel will display a graphical representation of the selected Workflow 
configuration. The lower right window will display the configuration tabs for the selected workflow. 
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11.2.3 Job Management Section 

 
Release to Next Step Button 

 

 
 

Releases the selected job from a hold applied in the Workflow Configuration (or a manual Pause) to the 
next process specified in that Workflow. This selection will be gray and inaccessible without first 
highlighting a job in the Job View Window. 
 
This function is also accessible by right-clicking on a job and choosing Release to next step from the 
pop-up menu or by selecting Release to next step from the Jobs Menu (Control-click on a 
Macintosh). 

 
Delete Button 

 

 
 

This function deletes the selected file. Delete can remove any job or sub-file within a job.  
For example, it is possible to use delete to remove an unwanted PGB (RIPed page or separation) files, or 
an unwanted color, before sending the job to output. Caution; deleting a sub file will remove it entirely 
from the system  
 

 Delete will only be available after highlighting an appropriate file in the Job List. 
This function is also accessible by right-clicking on a job and choosing Delete from the pop-up menu or 
by selecting Delete from the Jobs Menu, or by using the Delete key on the keyboard . 

 
Restart Job Button 

 

 
 

Clicking this Button will open a list of established Workflows in the system. Choosing one of the 
Workflows listed will cause the selected job to restart from the beginning using the chosen Workflow. 
 
This function is also accessible by right-clicking on a job and choosing Restart Job from the pop-up 
menu or by selecting Restart Job from the Jobs Menu (Control-click on a Macintosh). In addition, 
dragging the job onto the new Workflow has the same effect. 
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Copy Job Button 
 

 
 

Clicking this Button will open a list of established Workflows in the system. Choosing one of the 
Workflows listed will cause the system to process a copy of the selected job by the Workflow chosen 
without affecting the original job. 
 
This function is also accessible by right-clicking on a job and choosing Copy Job from the pop-up menu 
or by selecting Copy Job from the Jobs Menu (Control-click on a Macintosh). In addition, dragging the 
job with the Control key (PC) or Option Key (Mac) has the same effect. 
 

Get Information Button 
 

 
 
Clicking this button opens the Job Information Window.  
 
This function is also accessible by right-clicking on a job and choosing Get Info from the pop-up menu 
(Control-click on a Macintosh). 
 
The Job Information Window provides an overview of the job. It can be used to change the job name 
reported in Navigator Client and enter data into the Custom Fields (see Section 3.7 of the Navigator 
Server User Guide). Other information displayed includes Job Status, the Workflow name where the job 
resides and a log of the job’s progress through the system. 

 
 
 
Open File Button 

 

 
 

Choosing this menu item will open the selected file in the proper editing/viewing program. For 
example, after highlighting a PDF file and selecting Open File, the PDF file will open in Adobe Acrobat 
for review and editing, provided Acrobat is available on the system. Similarly, The Viewer will launch 
after highlighting a PGB file (a RIPed page or separation) and selecting Open File.  
 

 Open File will only be available after selecting an editable or viewable file type in the Job List 
window. 

 This function is also accessible by right-clicking on a job and choosing Open File from the pop-up 
menu, by clicking the Open File Button on the Tool Bar, or double-clicking on the PGB or PDF 
file. (PDF files will only open if you have Adobe Acrobat or Acrobat Reader installed on the 
system.)  

 
See Appendix A for a description of the Viewer and Viewer functionality. 
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11.3 Post-Processing Bar 

 

 
 

The Post-Processing Bar is an informational icon. It illustrates any actions that will be taken after the 
selected Workflow has completed processing of a submitted file. The Post-Processing Bar displays three 
post-processing functions. 
 
If the icon in the Bar appears in color, that function has been activated for the current Workflow. If it is 
gray, the corresponding function is not active. Each Post-Processing function is available in a sub-section 
of the “General” Workflow Configuration Tab, discussed later in this Chapter. 

 
Delete  

 
 

Delete instructs the system when to delete jobs. Selecting When Necessary instructs the system to delete 
the oldest jobs in the system when it reaches a default limit of 250 jobs. 

 
Archive 

 

 
 

Archive tells the system to Archive completed files. Archiving will take place when the files are 
scheduled for deletion from the system. 

 
Send to Another Workflow 

 

 
 

This icon indicates that completed files will move on to another established Workflow for further 
processing. 
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11.4 The Job List Panel 

The Job List Panel will take up the entire right side of the Client window or the lower right side of the Client, depending 
on the Mode the Client is in. When viewing All Jobs, All Held Jobs or All Completed Jobs, the Job List Panel will take up 
the entire right side of the Window. 
 

Job List Panel 

 
 

 
 

 
Four main functions are possible from within the Job View Window; searching for jobs, reviewing and sorting Job 
information, opening editable or viewable files and controlling Job files. 
 
The Job View Window appears in columns and rows. The columns provide different information about each job. Columns 
are configurable and adjustable for size. Each row in the Job View Window will contain information about a specific job or 
items contained within the Job, if the Job Information has been expanded. 
 

11.5 Items in the Job View Window 

 

Column Headings 
 

 
 

 

Job Information Rows 
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Expansion Buttons 
 

 
 

 
Found at the far left of the Job information row, these buttons are used to expand (+) or contract (-) the 
information for the selected job. 
 

 
Job Status Icons 

 

   Green indicates the Job is Scheduled, Idle or Running.  

  Yellow indicates that the Job is Paused or on hold.  

  Red indicates that the job caused an error.  

  Blue indicates that the job is complete. This icon will appear as a blue circle on the Mac Client. 
 

If the Job View has been set to show the expanded view, the Job Status icons on the PC will point 
downward as illustrated under Expanded Job View below. 

 
 
Location Icons 
 

Location icons indicate the location of files used by - or generated during - the processing of a job. Each 
location is specified by a location icon followed by the name of the Action completed to create the file 
found in that location.  

Location Icons 
 

 
 

The expanded Location Tree shown above illustrates the various steps and files produced in a workflow 
that includes the Stabilizer, Preflight, PDF Checker and RIP Actions.  
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 Page 

79 

 
  

11.6 File Type Icons 

 
File Type icons appear in a number of different styles and colors. Rather than display them all, four representative 

types are shown below: 

 
PostScript File Icon 

 Identifies the file as PostScript 
 
PDF file Icon 

Identifies the file as PDF 
 
Preflight Report Icon 

Identifies the file as a Preflight Report File. The system generates Preflight reports in PDF, 
viewable in any PDF viewing or editing software. 
 
RIPed CMYK Separation Icon 

 Identifies a RIPed CMYK or Gray separation The color of this icon will change depending on the 
separation color. 
 
RIPed Pantone Color Separation Icon 

 Specifies a RIPed Pantone Spot Color separation  
 
RIPed Composite Page Buffer 

 Specifies a RIPed composite page buffer, usually for a proofing device 
 
Unspecified Color RIPed Separation Icon 

 Specifies a RIPed separation of unknown color, usually a Black or Spot separation that has not been 
properly identified to the system. 

 

11.7 Expanded Job View 

Below is an example of an expanded job view displaying various job elements with Job View icons. 
 

Expanded Job Tree 
 

 
 

11.8 Column Heading Functions 

The Job View window contains a number of headings. There are standard heading fields that are not changeable and 
heading fields that are configurable to suit the information needs of a company’s internal procedures.  
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Standard Headings/Columns 
Standard Column Headings can be turned on and off using the Jobs/Column Headings menu but they 
cannot be altered. The one exception is the Job Name heading which is always on. See Chapter 3 for 
more information about turning on and off display of Job View Columns 
 
Job Name 
Displays the Job Name as specified in the Workflow Configuration “Hot Folder” tab or as set in the Jobs 
Information window (see above and Chapter 3 for more information.)  

 
Job Number 
Displays the Job Number. This is a continuously incremented number applied sequentially to jobs as they 
arrive in the Navigator Server system. 
 
Status 
This column displays processing status of the job. It will show if the job is held, processing (RIPing, 
Stabilizing, etc.), paused, post-processing, or completed. 
 
Workflow 
Displays the Workflow the Job is currently assigned to / processed by. 
 
Priority 
Displays the priority setting for the job. Job priorities can be set to Low, Medium, and High. They can 
be set for individual jobs or for all jobs coming into the system from a particular workflow. Priority will 
directly affect the order in which Navigator Server processes jobs. See Section 8.3.1 for more 
information about setting job priority. 
 
Status Message 
This column displays messages that may clarify the Job’s status, such as error messages sent by the RIP. 

 
Configurable Headings 
There are four configurable headings. The view of these headings can be switched on and off in the same 
manner as the standard column headings. The naming of these fields is performed in the Navigator 
Server.  

 
Adjusting Column/Heading Size 
The size of each column is adjustable by clicking and holding the mouse on the left division or gutter 
between the columns. (An example using the Job Name Column appears by the arrow below.) While 
holding the mouse button down, drag the column gutter left to decrease the size of the column view and 
right to increase it. 
 

Column Adjustment 
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It is possible to make a column disappear by dragging the gutter too far to the left. If this occurs, go to 
the Jobs/Column Headings menu and switch off the column that has disappeared. Switch it back on and 
the column will return. 

 
Sorting On Job Heading 
Clinking on a column heading will sort jobs according to the information in that column. A small arrow 
will appear in the column heading to indicate if the sort is in ascending or descending order. Clicking on 
the column heading again will change the sort order to the opposite of its previous setting. 
 

11.9 Controlling Jobs in the Job View Window 

Workflow functions for each Job are controllable from within the Job View window. Clicking the mouse while 
on a job or a sub-file of the job will highlight the Job or sub-file, and right-clicking on the job or a sub-file of the 
job will open the Job Functions Menu (Control-click on the Mac). 
 

Job Controls 
 

 
 

 
The functions of this pull-down menu are the same as the corresponding functions in the Jobs Menu found in the 
menu bar. See the explanation of Jobs Menu functions earlier in this chapter for a description of each menu 
selection. 
 

  



 

 

 Page 

82 

 
  

11.10 Display Windows in Workflow Edit Mode 

Any time a user creates or edits a workflow, the Client reverts to workflow edit mode. The Client window changes to 
show RIP Actions, PDF Actions and Output Actions to the left, the selected Workflow Diagram on the top right and the 
Workflow Edit Tabs on the bottom right.  
 

Workflow Edit Mode 
 

 

 
 

The Workflow Edit Tabs appearing will depend on which components were selected for a particular Workflow. As a 
system grows, users can add new Actions and these will have their own Tabs. To select a tabbed dialog, simply click on the 
named tab.  
 

11.10.1 Workflow Edit Tabs 

11.10.2 General 

The General Tab contains the following Workflow configuration settings: 
 
Workflow Name 
Use this selection to enter or change the selected workflow name. 
 
Priority 
Three selections are available which will determine processing priority: Low, Normal and High. 
 
Get Ahead 
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This number represents the number of jobs the system will “pre-schedule” for processing. If, for 
instance, there are 10 new jobs in a workflow and the Get Ahead is set for 5, the system will schedule 
five of the jobs for processing. The remainder of the new jobs will be in “idle” mode. As each job finishes 
processing, the system will add the next new job, keeping the total of scheduled jobs at 5 or less, until all 
jobs complete.  
 
To optimize the workflow, change the Get Ahead entry to the desired number. 
 
Get Ahead is also available when more than one RIP action is set in the same workflow. By using 
multiple RIP Actions (attached to different RIPs) it is possible to “load balance” the RIPs. Setting a Get 
Ahead value will make sure that one of the RIPs will never be sent more jobs than the other RIP in 
excess of the established Get Ahead number.  
 
That is, with a Get Ahead of 5, the system will pre-schedule five jobs for both RIPs. If one RIP is 
significantly faster, it is possible for jobs to remain scheduled for the slower RIP after the faster one 
finishes. In this case, a lower number (zero) is more conducive to equal distribution of jobs between two 
RIPs of different speeds. 

 
When Job Completes Section 

This special section tells Navigator Server what to do with job files after all processing in the selected 
Workflow is complete. There are three choices as described below:  

 
Send to Workflow 

This is a very powerful tool for setting up complex workflows. By choosing to send a job to another 
Workflow after completion in the specified Workflow, the system can perform multiple tasks on the 
same job without user intervention.  
 
For instance, it is possible to link a workflow set up for proofing to a workflow set up to drive an 
imagesetter. In this way jobs can be proofed and then imaged without having to reprint the job or 
manually restart the job. 

 
Archive 

Enabling this option will tell the system to Archive completed files. The system will store the original file 
in the Archive folder specified in the Navigator Server. Archiving will take place according to the 
deletion settings in the Navigator Server. Turning on Archive when “Send to workflow” is selected will 
have no effect. 

 
Delete 

After checking this selection, the system will delete files either immediately upon completion or as 
necessary after reaching a limit of jobs. This limit is editable in the “Server Settings” dialog box in 
Navigator Server.   

11.10.3 HotFolder 

The Hot Folder tab contains the following options: 
 
Input Folder 

This field specifies the folder a workflow watches to bring jobs into the system. Navigator Server 
establishes a default folder for each workflow a user creates. In most cases this default folder will be 
sufficient and no additional configuration is necessary. With the PC Client, the default folder is 
changeable using the Browse button.  
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The Restore Defaults button resets the Input Folder to its default setting. 

 
Hold After 

Checking this box will cause the system to immediately place newly arriving jobs using this workflow on 
hold. 
 
Once held, users can make changes to the Job’s Custom Information Fields, or restart jobs in a different 
workflow. 

 
Sample Job Name 

This field shows an example of the how job names will appear in the Navigator Server system with the 
words “My Sample Job” representing the incoming job name. As you add or remove options to the job 
naming template this example field will reflect the changes. 

 
Job Name Prefix, Body and Suffix 

The three settings, Prefix, Body and Suffix will add information to the displayed job name in the Client. 
Any mixture of the available settings is acceptable, including a custom prefix and custom suffix field. 
Prefix and suffix settings can also be disabled. However, there must always be a setting for body. 

 

11.10.4 Copy Action 

 
Copy file to 

This function will copy any file to another workflow. RIP Manager creates an entirely new job based on 
the file copied.  
 
For example, consider a RIP Manager workflow containing a Stabilizer Action set to convert PostScript 
to PDF, followed by a Copy File Action, a RIP Action, and an Output Action. If the original file 
submitted to RIP Manager is a PostScript file, the Stabilizer will convert it to a PDF. The Copy File 
Action (because it immediately follows the Stabilizer Action) will copy the resulting PDF file - as a new 
job - to whatever workflow the user set up in this Copy file to selection. This could be used to move 
the PDF to a workflow creating a proof based on the PDF while the original PDF continues on to RIPing 
for high-resolution output. 
 
The only limitations to the Copy Action are those established by the RIP Manager Actions and the 
creativity of the RIP Manager user. 
 

Hold After 
Checking this box will cause the system to place jobs on hold immediately after the Copy Action. 
 
Once held, the user can edit or view the sub-job created by the Copy Action, provided the proper 
viewing and editing software is present on the Client computer and viewing and editing is appropriate 
for the sub-job type. For example, if a full version of Adobe Acrobat resides on the Client computer, the 
user can view and edit PDF jobs. 

11.10.5 Export Action 

Export Action paths are configurable in either the client or the server.  The reasons for choosing one over the 
other are covered in the Server configuration section on Export Actions. The Export Action will copy whatever 
final file the preceding action creates, to a folder specified.  If you need to have a single file both Exported and 
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processed by another workflow, then you could precede the Export Action with a Copy Action. The Copy Action 
will send a copy of the file to the other Workflow and the Export Action will then export the original file.  
 

11.10.6 PrintJob Action 

By default, the PrintJob Action will take a job, convert it to TIFF, and output it to the Windows Print Spooler 
and through it to the printer specified. 
 
If the ‘Direct Output’ option is checked in the PrintJob Action configuration dialog in the Server, it is important 
that the file being sent out through the PrintJob Action be of the proper type for the target printer. For example, 
if a user configures the PrintJob Action to send files to a PostScript Level 2 printer, the file being sent must be in 
PostScript Level 2 or earlier format to prevent errors from occurring. 

11.10.7 RIP Action 

There are several options in the RIP Action tab: Page Setup, Hold After and Refresh Page Setups. Each is 
explained below. 
 
Page Setup 
The selections in the Page Setup pull-down menu represent the Page Setups (RIPing parameters) set in the RIP 
associated with the selected RIP Action. All Page Setups established in the target RIP will be available and display 
here.  
 
Selecting one of the Page Setups listed will instruct RIP Manager to send jobs entering this workflow through the 
RIP using the parameters in the specified Page Setup. Typically, users will configure the system with at least one 
workflow for each Page Setup on the RIP. 
 
Hold After 
Checking this box will cause the system to place RIPed jobs using this workflow on hold. (Once held, users can 
preview jobs using the viewer before releasing them for further processing. 

 
 Refresh Page Setups 

Clicking this button causes RIP Manager to fetch a new page setup list from the RIP. Use this after creating a new 
page setup that does not appear in the list. 

 
 Page Setup Configuration 

You may view or change the settings of your chosen RIP Page Setup from the RIP tab either globally or for 
individual jobs. 

 

11.10.8 Output Action 

Output Actions are not configurable, except in the case of a certain few output devices.  These cases are covered 
in their respective plug-in manuals.  Regardless of their configurability, Output Actions are an important visual 
cue in the Workflow Diagram. Output Actions represent the device to which the RIPed files will be output. If 
there is more than one imaging device attached to the RIP, the system will determine the final output based on 
the RIP’s Page Setup. See the RIP documentation for details on configuring Page Setups and selecting output 
devices. 

 
 

11.10.9 Direct Output Action 
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The Direct Output action is configurable to the extent that you choose a RIP page setup.  Direct Output is a 
variant RIP action which allows for no pause between ripping and output. 

  
 

Chapter 13 – Workflow Options 
 

Chapters for  imposition, ink remapping, PDF conversion and preflighting, and scriptable hot 
folders are available in separate documents on the installation CD and also at Xitron’s web site. 
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Appendix A – The Viewer 
 
Note: RIP Manager offers two choices for the Viewer; the standard Viewer and Viewer Pro. The additional features in the 
Pro Viewer are discussed at the end of this Appendix in section A.4 

A.1 Key Features 

 Multiple scale factors – can zoom in and out. 

 Intelligent ordering of files into jobs, pages and separations. 

 Can rotate, mirror and negate the view 

 Can view Traps and Rulers 

 Accurate color mixing and display 

 

PageBuffer Files  
This appendix makes reference to PageBuffer files and it is helpful to understand what these files are and where they reside. 
Harlequin RIPs generate PageBuffer files to store RIPed (bitmap) data. The RIP accesses these files when viewing or 
outputting jobs. Each page or flat to be output is held in one PageBuffer file, so the system stores multiple-page jobs in 
multiple PageBuffers. Some PageBuffer files (usually lower resolution proofing output) contain all the colors in a page or 
flat while others, (usually high resolution screened output) contain only a single color.  

A.2 Configuring the Viewer 

The Configuration Settings enable you to modify settings that are applicable to the whole of the Viewer. The settings apply 
only to the RIP Manager client at which they are made. They will not affect other copies of the Viewer on other 
computers.  
 
To modify the Viewer Configuration Settings: 
 

Select Viewer Properties from the Jobs menu in the RIP Manager Client. The window shown below will appear. 

 Viewer Configuration Settings 
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Work Space Path sets the location of all temporary files created during processing. 

Allocate to sets how much disk space the Viewer may use. This value should be at least 1000 Mb for small files 
but will need to be 10000 or more for larger files. 

Down-sample controls the Viewer’s down sampling. (Down sampling is the process of reducing the resolution 
of an image by calculating average pixel values for an array of input pixels which are used to create a smaller 
number of output pixels. The options are: 

o Down-sample all factors on view - This option will process all the possible scale factors from 100% 
to the factor that best fits in screen when selecting the view button. 

o To best fit in roam window - This option instructs the system to down-sample by the factor required 
to fit the image into the roam window. 

o Screen resolution and below - Only the closest factor to the screen resolution and those below it 
will be down-sampled. Recommended for best performance. 

Default View sets the default mode for the initial view of the page. Best Fit produces a full-screen view while 
Actual Size shows only a small piece of the full size job. 

Units of Measurement allows the user to set default units for measurements made using the viewer.  

TIFF Pagination Filter allows a filename matching filter to be selected, which determines how the viewer 
groups TIFF separations into pages, depending on their filenames. Use the ‘+’ button to display a dialog allowing 
you to add a new filter, and the ‘-‘ button to delete the currently selected filter. All workflows will use the 
selected filter.  

Ready-made filters are provided as follows: 

Default: Matches the standard Navigator Server name handling; this is equivalent to the “Navigator” filename 
matching setup used for the KeySetter and ROOMProof Actions. 

Unique filenames: The same as the above, but for use when the ‘Unique filenames’ checkbox is selected  in the 
RIP’s TIFF Plugin configuration dialog. 

Sierra: To match the Xenith Sierra TIFF filename convention. 

 

Please see Section A.4.6 Defining TIFF File Name Filters for details of the filter syntax.  

 

A.3 Using the Viewer 

Interface Components 
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The Roam Window 
The Roam Window is the area in which the system will display image data.  
 
The Navigator Window 
The function of the Navigator Window is to provide a quick means of moving around large images. The system displays a 
reduced view of the full size image in the Navigator Window. A green block indicates which area of the image the ROAM 
window displays. 
 
The Toolbar 
The Toolbar contains a set of icons that correspond to items in the top line menus of commonly used functions and add 
additional user functionality. 

 

 Zoom In - Enlarges the displayed image by going to the next zoom factor. 
 

 Zoom Out - Reduces the displayed image by going to the next zoom factor. 
 

 Full Size - Displays the image on screen at a ratio of 1 image pixel to 1 screen pixel. 
 

 

 Fit To Screen - Calculates the best scale factor to display the whole image in the Roam Window. 
 

 Rulers - Switches the ruler display On or Off. This function is also accessible from the View menu or by using 
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Ctrl / Command + R. 
 

 Show Negative - Switches the image display to Negative or Positive. This function is also accessible from the 
View menu or by using Ctrl / Command + S. 

 

    Custom Color Manager - Allows you to set up a list of custom colors for viewing image separations. This 
function is also accessible from the Tools menu. 
 

  Trap Black - Switches black separations to 50% gray to assist with proofing black traps. 

 
    Map Pages - Allows you to remap the Separation to Page structure of a job. This function is also accessible from 

the Tools menu or by using Ctrl / Command + M. 
 

Scale Box 
The Scale Box allows you to select a scale factor to apply to an image in the Roam Window. 
 
The Menu Bar  
The Menu Bar contains the following Menus and Options. 

The View Menu 

 Show Negative = Ctrl / Command + S 

 Trap Black = Ctrl / Command + T 

 Hand Speed (the speed with which the image moves when panned using the mouse)  

o Normal = Ctrl / Command + 1 
o Medium  = Ctrl / Command + 2 
o Fast = Ctrl / Command + 3 

 Dock Navigator = Ctrl / Command + N 

 Rulers = Ctrl / Command + R 

 Control Box = Ctrl / Command + B 

 Tool Bar 

 Status Bar 

The Tools Menu 

 Purge Workspace Folder (delete all down-sampled image files to recover disk space). 

 Custom Color Manager (to define ROAM colors for spot color jobs, see details later in this Appendix). 
 

Page List Box 
The Page List Box displays a list of pages and separations for a selected job. 
 
Info Tab 
The Info Tab displays information about the job being viewed. 
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Incorrect Separation Mapping 

Although the RIP does a very good job of linking separations with pages, there are some cases where this is not possible. 
The Viewer allows a system whereby this mapping problem can be corrected. 
 
Take the Following as an example: 

 A RIPed job displays in the Viewer with the Colors CMYK listed as 1 color per page e.g. Page 1 – C, Page 2 – M 
etc., as shown below. 
 

Example of Incorrect Color Mapping 

 
   

 The mapping for this job should in fact be Page 1 – CMYK etc., as shown in figure on next page. 
 
 

Correct Color Mapping 
 

   
 

To correct the job mapping: 

 Select the Map Pages icon from the Toolbar. 
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The Viewer will search for a recurring pattern and arrange the separations into pages based on this pattern. In most cases 
this pattern mapping will be successful, but will not work in the case where an extra color represents an individual page. 
To overcome this, the Viewer will prompt you to confirm whether non-recurring colors should be treated as part of the 
recurring pattern or as individual pages.  

Selecting and Deselecting Pages and Separations 

Initially, all of the pages except the first in the Page List box will be collapsed but can be expanded individually to show the 
separations that comprise each page. Separations can be selected or deselected as a page group, or as individual separations. 

 To select all of the separations from a page, double-click on the Page Number in the list. 

 To deselect all the separations click on the Page Number in the list. 

 To select an individual separation click on the Separation Name. 

 To select multiple separations click on a Separation Name, then hold down the Shift or Ctrl / Command keys 
while clicking on the Remaining Separations. 

 To deselect separations hold down the Ctrl / Command key while left-clicking on the Separation Name. Once 
you have selected the separations, select the View button to process the image view. 

Roaming an Image 

After selecting the View button, the Viewer will begin processing the Roam Image. At the same time the Viewer will 
begin producing reduced versions of the image, from which it will create the Navigator View. Although the Navigator 
image may take some time to process you will still be able to Roam around the image and click on the Navigator window. 
 
The Viewer offers three methods of Roaming around an image: 

 Using the scrollbars – There are three ways to roam using the Scrollbars: 
o Clicking on the Arrows at either end of the Scrollbar. 
o Clicking anywhere on the Scrollbar. 
o Dragging the Thumb-tab to any position on the Scrollbar. 

 Using the Hand Tool – To roam using the Hand Tool, click an area of the image in the Roam Window and drag 
the image while holding down the mouse button. 

The Hand Tool has three speed settings selectable from the Hand Speed option under the View menu. The options 
are: 

o Normal = Ctrl / Command + 1 
o Medium = Ctrl / Command + 2 
o Fast = Ctrl / Command + 3 

 
If the Hand Speed is set to Normal, you can change it temporarily by holding down the Ctrl / Command or the Shift 
key while dragging the image. 
 

 Using the Navigator Window 
Use the Navigator Window for moving quickly from one area of the image to another. To jump to an area of the 
image, just click on the area of the image in the Navigator Window and the Roam Window will update with the 
selected image data. 
 
The Navigator Window is, by default, docked underneath the Page List box in an area that it shares with the Job Info 
box. The Navigator Window may however, be positioned anywhere within the Main Window that you choose. There 
are several ways to Undock the Navigator Window: 
 

 Double click on the Navigator Tab. 
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 Drag the Navigator Tab anywhere on the screen. 

 Select the Undock Navigator option from the Tools menu or use Ctrl / Command + N. 
 

The Navigator Window may be Docked using the following methods: 
 

o Double click on the Navigator Windows Title Bar (PC only). 
o Select the Navigator Windows Close Icon. 
o Select the Dock Navigator option from the Tools menu or use Ctrl / Command + N. 

 

 
You can resize the Navigator Image up to a size of 512 x 
512 pixels by dragging the sides or the corner of the 
Navigator window. 

Enlarging and Reducing the Image View 

After selecting the View button, the Viewer may begin creating reduced view images depending on the down-sampling 
option that you chose from the Viewer Properties menu. The process of image reduction is very computer intensive and 
may take some time for large files. The reduction factors available will halve each time - up to the factor where the image 
will fit into the Roam Window, e.g. 100%, 50%, 25%, 12.5% etc. In addition, enlarged Views up to 800% are available 
from the Scale Box. The viewer will write reduced view images to disk to eliminate the need for reprocessing 
unnecessarily. 
 
Selecting a Scale Factor from the Scale Box will update the image view in the Roam Window accordingly. Factors not 
previously processed due to a choice of down-sampling method will display with a red cross next to them. Selecting one of 

these factors will instruct the viewer to begin processing it. Process all previously unprocessed factors by selecting the  
icon on the right of the Scale Box. 
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The Viewer stores the Reduce View Images in the disk area defined in the configuration screen. Once the total size of the 
files reaches the space set, the system deletes the oldest files in the folder. 
 

 The 50% and 25% roam factors take the longest to down-
sample so it is best to avoid these unless you really need 
them. 

Rotating and Mirroring the Viewed Image 

The Viewer incorporates the ability to rotate viewed images clockwise and counter-clockwise in 90° increments. Select the 

 icon to rotate the image counter-clockwise and the  icon to rotate the image clockwise. Mirror-flip the image by 

selecting the  icon from the Toolbar. 

Switching Separations On or Off during Viewing 

The Viewer allows you to switch separations On or Off while viewing jobs. Separations can be turned On or Off without 
having to reselect the View button unless all of the separations are deselected. To turn a separation On or Off, hold down 
the Ctrl / Command key and click on the Separation Name. 

Black Traps 

The Viewer incorporates the ability to switch the black view from 100% black to 50% black. This feature was introduced 
to allow users to proof traps where the trap consists of black and another color. To switch the black mode, View a job and 

click on the  icon or use Ctrl / Command + T to switch between Trap Black and Normal Black modes. 

Modifying the Roam Color of a Separation 

Change the color used to view a separation by selecting a predefined color or selecting a custom color. To change the 
display color for a particular separation: 

 PC – right-click or double-click on the Separation Name. 

 Mac – double-click on the Separation Name. 

 Select Change Color to change only the selected separation. 

 Select Change All Colors to change the color of all the jobs separations with the same name as the one selected 
 

Custom Color Manager 
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Color Pickers 
 

  
 
 

1. You can select a Color from the list of Predefined Colors or select Other for a Custom Color selection. 
2. If you select from the Predefined List, you can select Select to implement the color change. 
3. If you select Other: 

 

 Select a Color from the Color Picker or type in the RGB values for a specific color. 

 Select OK. 

 Select Yes if you want to add the new Color to the List of Custom Colors or No to use it only for this job. 

 If you select No, the color change will be implemented, if you select Yes you will be asked to supply a 
unique name to identify the new Color. 

 
Predefining Colors 

Predefined colors can be created at any stage using the Custom Color Manager which can be launched by selecting the 

Custom Color Manager option from the Tools menu or selecting the  icon from the Toolbar. 
 

Custom Color Manager 
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Adding a Color 

1. Select Custom Color Manager option from the Tools menu or the  icon from the Toolbar. 
2. Select the Add button. 
3. Enter a Unique Name for the new color. 
4. Select a Color from the Color Picker or type in the RGB values for a specific color. 
5. Select OK to return to the Custom Color Manager screen. 

 
Editing a Custom Color 

1. Select Custom Color Manager option from the Tools menu or the  icon from the Toolbar. 
2. Select the Color to Edit. 
3. Select the Edit button. 
4. When prompted for a Color Name, select OK. 
5. Select a Color from the Color Picker or type in the RGB values for a specific color. 
6. Select OK to return to the Custom Color Manager screen. 

Deleting a Custom Color 

1. Select the Custom Color Manager option from the Tools menu or the  icon from the Toolbar. 
2. Select the Color to Delete. 
3. Select the Delete button. 

A.4 ViewerPro 

The ViewerPro option includes a number of additional tools and controls. The main Window is similar to that of the 
standard Viewer, as shown below. 

 

ViewerPro Main Window 
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The additional features of ViewerPro include the following: 

A.4.1 Measurement Tools 

 

Click the  icon or select Tools > View Tools > Measurement Tool from the menu system. 
 
The Measurement Tools window shown on page 90 will appear. 
 
 
 

Measurement Tools Window 
 

 
 
 

There are 4 measurement tools: 
 
 

 Object Measurement (1D) 
 
The Object Measurement Tool (1D)  allows you to calculate the distance and angle between two points by clicking on the 
first point and then clicking on the second point. Once you have clicked on the first point you can move the image to get to 
the second point by holding the mouse button down and dragging the cursor. The selection of the second point is only 
completed if the mouse is clicked without moving the cursor. 
 

 Object Measurement (2D) 
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The Object Measurement Tool (2D) allows you to calculate the Width and Height of an object by drawing a box. Once 
you have clicked on the first point you can you can move the image to get to the second point by holding the mouse button 
down and dragging the cursor. The selection of the second point is only completed if the mouse is clicked without moving 
the cursor. Holding the Ctrl / Command key while moving constrains the tool to a square measurement area.  
 
The Width and Height measurements are constantly displayed in the Tools Window and updated as the mouse moves. This 
measurement only becomes static once a second point is specified. It is possible to take two sets of measurements by 
selecting Measurement 1 or Measurement 2 from the Tools Window. 
 

 Screen Measurement 
 
The Screen Measurement Tool allows you to calculate the screen angle and screen ruling of a displayed image. To calculate 
the angle and ruling choose an area of the image with a well defined screen pattern with clear and self standing dots. (This 
is best done at 800% zoom so you can locate the screen dots clearly). Click on the center of a dot and the center of the 
adjacent dot running in the direction of the screen. The result will be displayed in the Tools Window. The unit of 
measurement that will be used to display the screen ruling is defined during the creation of the Input Sources. It is possible 
to take two sets of measurements by selecting Measurement 1 or Measurement 2 from the Tools Window. 
 

 Density Measurement 
 
The Density Measurement Tool allows you check the color composition of a particular area of the image. The tool can be 

used by entering a sampling area in the edit box to the right of the  button and then moving the cursor over the image, 
which will display the color composition of the area. A density measurement can also be taken by clicking a point on the 
image and dragging a box around the area that you wish to sample, then clicking a second point to confirm the selection 
area. 
 
A.4.2 Grid Lines 
Viewer Pro includes the ability to overlay a grid on top of the viewed image. The Grid display can be switched On or Off 

by clicking the  icon or using the shortcut Shift + Ctrl / Command + G. To specify the grid frequency, type the 
desired value into the edit box to the right of the icon. A frequency of zero will create a grid that matches the current ruler 
marks. All other frequencies will create a grid using the currently selected unit of measurement for distance. 
 
A.4.3 View as Black 
ViewerPro includes the option to switch the viewed selection to Black / White with a single click. This is useful to check 
for moiré or to view a separation in black without having to change the separation’s view color. To switch the view to 

Black / White or back to color, click the  icon or use the shortcut Ctrl / Command + B. 
 
A.4.4 Ink Limits 
ViewerPro includes the ability to display Ink Limit warnings. This is important to prevent jobs from over-inking while on 

the press. To switch the Ink Limit warning on, click the  icon or use the shortcut Ctrl / Command + L. The allowable 
percentage ink density can be specified by typing the desired value in the edit box to the right of the icon. The color used 
to indicate areas that exceed the specified value can be changed by clicking on the color swatch to the right of the edit box 
and selecting a new color. The following example shows an image with the Ink Limit set to 280%. The areas that exceed 
280% are clearly indicated in the Ink Limit Color (default red). 
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Ink Limit Color 

 
 

 
 

A.4.5 Ink Coverage 

Another feature that is exclusive to ViewerPro is Ink Coverage reporting. This feature is useful in that is allows you to 
calculate what area of each separation is covered by ink. The percentage coverage for each separation is always displayed to 
the right of the separation color in the page list. If you refer to the screen shots above, you will see that the Cyan 
Separation has a 27% Coverage; the Magenta Separation has a 23% Coverage; the Yellow Separation also has a 23% 
Coverage and the Black Separation has a 9% Coverage. The Image Area of the job is displayed in the Info Window and in 
the case of this example the page is 36 sq. inches. Given the image area of the job and the percentage coverage for each 
separation it is easy to calculate the area coverage for each separation. 

 
A.4.6 Defining TIFF File Name Filters  
As described in section A.2, it is possible to define filter strings which specify how separation names should be analysed for 
page grouping. Although TIFF files do contain the ability to store job names, job numbers, page numbers and so on, using 
baseline tags, many applications do not store this information in the TIFF file. An application such as a RIP which processes 
multiple jobs containing multiple pages, containing multiple separations also has to solve the issue of uniquely naming the 
TIFF files produced. The way most applications solve this is to use the job name, job number, page numbers and so on as 
part of the name that it gives to the TIFF file. Unfortunately as previously mentioned, there is no standard for this, and 
different applications use different methods.  
 
For example one application might output TIFF files as follows:  
01Firstjob01c.tif  

01Firstjob01m.tif  

01Firstjob01y.tif  

01Firstjob01k.tif  

01Firstjob02c.tif  

...  
01Firstjob02k.tif  

...  
01Firstjob15k.tif  

02Secondjob01c.tif  

...  
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02Secondjob01k.tif 

In this case, the first two digits represent the Job Number, the following text the Job Name, the following number the Page 
Number, and the following character (an abbreviation of) the Color Name (Cyan - c, Magenta - m, Yellow - y and Black - 
k). This means that 01Firstjob01c.tif translates to;  

• Job Number – 01  
• Job Name – Firstjob  
• Page Number – 01  
• Color – Cyan  

The File Name Filter mechanism has, due to this naming problem, been designed as a flexible method of extracting the 
relevant information from the given TIFF file names. Depending on the source providing the TIFF files, a new filter can be 
created (or an existing one reused) that can parse the file name and extract the expected/required info.  

The Filter String specified in the Define Filter dialog allows one to enter a string which contains either Literal Text (which 
is matched against the text in the file name), or Special Characters (which provide extended matching capabilities), or 
Special Modifiers (which provide information extraction capabilities). 
 

A.4.6.1 File Name Filter String Format  

Literal Text  

This is straightforward text which must match part of the file name; all upper case characters in both the Filter String and 
File Name are converted to lower case when comparing for a match. For example, if all TIFF file names end in “.tif” then 
this literal string would be visible at the end of the Filter String. E.g. “*.tif” (the “*” character will be explained later 
on).  

Note that in this case a TIFF file ending with “.tiff” would not be matched. 

 

Special Modifiers  

These are always prefixed with a “%” character. There are eight of these:  

a) “%j” - This is used to extract the following text and use it as the Job Name.  

b) “%c” - This is used to extract the following text and use it as the Color Name.  

c) “%s” - This is used to extract the following text and use it as the Page Side Name.  

d) “%t” - This is used to extract the following text which is then discarded.  

e) “%n” - This is used to extract the following integer and use it as the Job Number.  

f) “%p” - This is used to extract the following integer and use it as the Page Number.  

g) “%r” - This is used to extract the following integer and use it as the Job Resolution.  

h) “%i” - This is used to extract the following integer which is then discarded.  

The number of characters making up either a string or integer can be specified using an optional integer between the “%” 
character and the modifier character. For example if the Color Name were specified as a single character, one would use 
“%1c” to match this and extract the color name. Note that in this case, for the color name to be used in FirstPROOF, it 
must exist in the Color Manager, either as the Name of a color, or as an Alias of a color. 

Consider the example sequence given above, starting with 01Firstjob01c.tif. In this case the job number can be extracted 
using “%n” (or “%2n”), the job name using “%j”, the page number using “%p” (or “%2p”) and the color name using “%c” 
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(or “%1c”). A Filter String for this could therefore be written as “%n%j%p%c.tif” or even better still as 
“%2n%j%2p%1c.tif[f]”.  

 

Special Modifier Length Restrictions  

As well as stating the precise number of characters to make up a field, a minimum and maximum number of characters can 
also be set. This is done by using a "-" sign before/after the minimum/maximum. For example, “%2-c” means 2 characters 
or more, “%-2c” means two characters at most, and “%2-4c” means between 2, 3 or 4 characters.  

 

Special Modifier Character Restrictions  

The Special Modifiers that represent strings (%j - Job Name, %c - Color Name, %s - Page Side, etc…) can be further 
restricted so that they only apply to certain characters. This is achieved by putting those characters inside braces immediately 
before the special modifier (“j”, “c”, “s”, etc…). A range of characters can be specified by using a “-” between the two. 
For example “%{1234567890a-zA-Z}c”, permits only all the digits as well as lower and upper characters.  

A good example of where this may be useful is if the incoming files are scans where the color is represented by a single 
letter “c”, “m”, “y” or “k”. The color can be precisely matched by using “%1c”, but can further be restricted by using 
“%1{cmyk}c”. 

This would be most useful if the scanned files were also mixed with general jobs, whereby the scanned files would then be 
detected by using a filter such as “%j[%1{cmyk}c]”. That is the file names are the job names, with any scans having a 
single letter (“c”, “m”, “y” or “k”) at the end.  

The restricted character set can also be “inverted” so as to exclude characters, by putting a “~” before the braces.  

A good example of this is where a file name consists of a job name followed by a color name, where the color name is known 
not to include a space. The job name and color name would then be correctly extracted by using a filter such as “%j %~{ 
}c”. If this is not done, then it is not always obvious which part of the file name is the job name, and which part of the file 
name is the color name.  

Consider a file name “Printing Unit Black”. A simple filter for this would be “%j %c” which means the job 
name followed by a space, followed by the color name. However, which part of this is the job name and which part is the 
color name? Is the job name “Printing” and the color name “Unit Black”, or, the job name “Printing Unit” 
and the color name “Black”. If one restricts the color name to not include a space, that is to use the filter “%j %~{ }c” 
then the color name has to be “Black”, and so the job name has to be “Printing Unit”.  

 

Special Modifier Content Restrictions  

The Special Modifiers that represent strings (“%j”- Job Name, “%c” - Color Name, “%s” - Page Side, etc…) can be 
further restricted so that their contents match certain criteria. This includes where part of one modifier contains another. 
This is achieved by putting the content restriction inside double-quotes immediately after the special modifier (“j”, “c”, 
“s”, etc…). The contents that must match can be any sequence of characters, including additional special characters or 
special modifiers. For example “%j="job_%n"”, specifies that the job name consists of “job_12345” where the 
“12345” is also the job number. As another example, “[%s="Back"]”, specifies that the Page Side (%s) is optional, 
but when it is present must be “Back”.  

This allows for very powerful job information extraction.  

 

Special Prefix  
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The start of a filter can also start with “..”. In this case the file name that is used in the matching process is prefixed with 
the folder in which it resides. For example, a file called “job.tif” in a folder “123” would normally be processed as 
“job.tif”. However, if the filter started with “..” then it would be processed as “123\job.tif” (PC) or 
“123:job.tif” (Mac). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 
 

Appendix B – Upgrades and system backups 
 
It is important to know where the system stores job and workflow data for the purposes of software upgrades and system 
backups.  
 

1. At the root level of the Navigator Server installation there are three files which contain information about the 
system configuration : xiflow.jobs, xiflow.actions and xiflow.wf.  

 
2. Files associated with the system, but not contained within the installation folder include the actual job data, 

archived jobs, and the hot folders used for job input.  These are usually at c:/Navigator/Workflows, 
c:/Navigator/Jobs, and c:/Navigator/Archives,  but you may check in the Navigator Server to find out for 
certain. 

 
There is a multi-level backup system in place to allow Navigator Server to automatically recover if these three databases 
ever become corrupted. As a further precaution, if the Server ever reports “Failed to load ‘X’ information. Press OK to 
continue using backup information or CANCEL to quit.”, with ‘jobs’, ‘workflow action’ or ‘workflow’ in place of ‘X’ 
depending on whether the Jobs, Actions or Workflows database is at fault”. If at this point you opt to quit the Server, 
please contact your support provider to investigate the problem with the assistance of the log files. If instead you choose to 
use the backup, your most recent changes (if any) will be lost. 
 
Load over installations of Navigator Server are possible. Navigator RIP does not handle load over installations. They 
require the use of the Migrate Utility. (See separate manual for Migrate Utility)  
 
The way to do a “clean install” of a Navigator Workflow system, including Server and RIP, is described below. 
 

1. Install the new version of Navigator Workflow to an entirely new folder. (Use the Workflow installer.) 
2. Install all required RIP plugins. 
3. Run the Global Graphics “Migrate” Utility to transfer the RIP settings from the old version of the RIP. 
4. Copy the “.jobs”, “.actions”, and “.wf” files from the root level of the old Server installation to the new one. 
5. Start the system. 

 
To do a loadover install, follow these instructions: 
 

1. Install the new version of Navigator RIP to an entirely new folder. (Use the RIP installer only.) 
2. Install all required RIP plugins. 
3. Install required RIP Utilities. 
4. Run the Global Graphics “Migrate” Utility to transfer the RIP settings from the old version of the RIP. 
5. Install the new version of Navigator Server into the same folder as the old version. 
6. Start the system. 

 
In either case, upgrades generally require an upgrade of each client application as well.   
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Appendix C – Special Page Setups 
 
The following Actions make use of the RIP and require the Page Setups mentioned below. 
 
KeySetter requires a Page Setup named “KeySetter”, configured as specified in Section 4.1 of the KeySetter User Guide. 
 
PrintJob requires a Page Setup named “PrintJob”, set to output to the TIFF plugin, and with separation style “Composite” 
selected. 
 
PrintJobTicket requires a Page Setup named “PJT”, set to output to the TIFF plugin, and with separation style 
“Halftone” selected. Within the Halftone separation style, please ensure that “(Other colors in job)” is set to “Yes” or “Not 
blank”. 
 
Any other required settings in these Page Setups will be configured automatically by the corresponding Action.   
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Appendix D – Apple Public Source License 
 
APPLE PUBLIC SOURCE LICENSE 

                 

Version 1.1 - April 19, 1999 

 

Please read this License carefully before downloading this software. By downloading and using this software, you are agreeing to be 
bound by the terms of this License. If you do not or cannot agree to the terms of this License, please do not download or use the software. 
 
1. General; Definitions. This License applies to any program or other work which Apple Computer, Inc. ("Apple") publicly announces as subject to this Apple Public Source 

License and which contains a notice placed by Apple identifying such program or work as "Original Code" and stating that it is subject to the terms of this Apple Public Source 

License version 1.1 (or subsequent version thereof), as it may be revised from time to time by Apple ("License"). As used in this License: 

 

1.1 "Affected Original Code" means only those specific portions of Original Code that allegedly infringe upon any party's intellectual property rights or are otherwise the subject 

of a claim of infringement. 

 

1.2 "Applicable Patent Rights" mean: (a) in the case where Apple is the grantor of rights, (i) claims of patents that are now or hereafter acquired, owned by or assigned to Apple 

and (ii) that cover subject matter contained in the Original Code, but only to the extent necessary to use, reproduce and/or distribute the Original Code without infringement; 

and (b) in the case where You are the grantor of rights, (i) claims of patents that are now or hereafter acquired, owned by or assigned to You and (ii) that cover subject matter in 

Your Modifications, taken alone or in combination with Original Code. 

 

1.3 "Covered Code" means the Original Code, Modifications, the combination of Original Code and any Modifications, and/or any respective portions thereof. 

 

1.4 "Deploy" means to use, sublicense or distribute Covered Code other than for Your internal research and development (R&D), and includes without limitation, any and all 

internal use or distribution of Covered Code within Your business or organization except for R&D use, as well as direct or indirect sublicensing or distribution of Covered Code 

by You to any third party in any form or manner. 

 

1.5 "Larger Work" means a work which combines Covered Code or portions thereof with code not governed by the terms of this License.  

 

1.6 "Modifications" mean any addition to, deletion from, and/or change to, the substance and/or structure of Covered Code. When code is released as a series of files, a 

Modification is: (a) any addition to or deletion from the contents of a file containing Covered Code; and/or (b) any new file or other representation of computer program 

statements that contains any part of Covered Code. 

 

1.7 "Original Code" means (a) the Source Code of a program or other work as originally made available by Apple under this License, including the Source Code of any updates or 

upgrades to such programs or works made available by Apple under this License, and that has been expressly identified by Apple as such in the header file(s) of such work; and 

(b) the object code compiled from such Source Code and originally made available by Apple under this License. 

 

1.8 "Source Code" means the human readable form of a program or other work that is suitable for making modifications to it, including all modules it contains, plus any 

associated interface definition files, scripts used to control compilation and installation of an executable (object code). 

 

1.9 "You" or "Your" means an individual or a legal entity exercising rights under this License. For legal entities, "You" or "Your" includes any entity which controls, is controlled 

by, or is under common control with, You, where "control" means (a) the power, direct or indirect, to cause the direction or management of such entity, whether by contract or 

otherwise, or (b) ownership of fifty percent (50%) or more of the outstanding shares or beneficial ownership of such entity. 

 

2. Permitted Uses; Conditions & Restrictions. Subject to the terms and conditions of this License, Apple hereby grants You, effective on the date You accept this License and 

download the Original Code, a world-wide, royalty-free, non- exclusive license, to the extent of Apple's Applicable Patent Rights and copyrights covering the Original Code, to do 

the following: 

 

2.1 You may use, copy, modify and distribute Original Code, with or without Modifications, solely for Your internal research and development, provided that You must in each 

instance: 

 

(a) retain and reproduce in all copies of Original Code the copyright and other proprietary notices and disclaimers of Apple as they appear in the Original Code, and keep intact 

all notices in the Original Code that refer to this License; 

 

(b) include a copy of this License with every copy of Source Code of Covered Code and documentation You distribute, and You may not offer or impose any terms on such Source 

Code that alter or restrict this License or the recipients' rights hereunder, except as permitted under Section 6; and 

 

(c) completely and accurately document all Modifications that you have made and the date of each such Modification, designate the version of the Original Code you used, 

prominently include a file carrying such information with the Modifications, and duplicate the notice in Exhibit A in each file of the Source Code of all such Modifications. 

 

2.2 You may Deploy Covered Code, provided that You must in each instance: 

 

(a) satisfy all the conditions of Section 2.1 with respect to the Source Code of the Covered Code; 

 

(b) make all Your Deployed Modifications publicly available in Source Code form via electronic distribution (e.g. download from a web site) under the terms of this License and 

subject to the license grants set forth in Section 3 below, and any additional terms You may choose to offer under Section 6. You must continue to make the Source Code of Your 

Deployed Modifications available for as long as you Deploy the Covered Code or twelve (12) months from the date of initial Deployment, whichever is longer; 

 

(c) if You Deploy Covered Code containing Modifications made by You, inform others of how to obtain those Modifications by filling out and submitting the information found at 

http://www.apple.com/publicsource/modifications.html, if available; and  

 

(d) if You Deploy Covered Code in object code, executable form only, include a prominent notice, in the code itself as well as in related documentation, stating that Source Code 

of the Covered Code is available under the terms of this License with information on how and where to obtain such Source Code. 

 

3. Your Grants. In consideration of, and as a condition to, the licenses granted to You under this License:  

 

(a) You hereby grant to Apple and all third parties a non-exclusive, royalty-free license, under Your Applicable Patent Rights and other intellectual property rights owned or 

controlled by You, to use, reproduce, modify, distribute and Deploy Your Modifications of the same scope and extent as Apple's licenses under Sections 2.1 and 2.2; and 

 

(b) You hereby grant to Apple and its subsidiaries a non-exclusive,  

worldwide, royalty-free, perpetual and irrevocable license, under Your Applicable Patent Rights and other intellectual property rights owned or controlled by You, to use, 

reproduce, execute, compile, display, perform, modify or have modified (for Apple and/or its subsidiaries), sublicense and distribute Your Modifications, in any form, through 

multiple tiers of distribution. 
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4. Larger Works. You may create a Larger Work by combining Covered Code with other code not governed by the terms of this License and distribute the Larger Work as a 

single product. In each such instance, You must make sure the requirements of this License are fulfilled for the Covered Code or any portion thereof. 

 

5. Limitations on Patent License. Except as expressly stated in Section 2, no other patent rights, express or implied, are granted by Apple herein. Modifications and/or Larger 

Works may require additional patent licenses from Apple which Apple may grant in its sole discretion. 

 

6. Additional Terms. You may choose to offer, and to charge a fee for, warranty, support, indemnity or liability obligations and/or other rights consistent with the scope of the 

license granted herein ("Additional Terms") to one or more recipients of Covered Code. However, You may do so only on Your own behalf and as Your sole responsibility, and not 

on behalf of Apple. You must obtain the recipient's agreement that any such Additional Terms are offered by You alone, and You hereby agree to indemnify, defend and hold 

Apple harmless for any liability incurred by or claims asserted against Apple by reason of any such Additional Terms. 

 

7. Versions of the License. Apple may publish revised and/or new versions of this License from time to time. Each version will be given a distinguishing version number. Once 

Original Code has been published under a particular version of this License, You may continue to use it under the terms of that version. You may also choose to use such 

Original Code under the terms of any subsequent version of this License published by Apple. No one other than Apple has the right to modify the terms applicable to Covered 

Code created under this License. 

 

8. NO WARRANTY OR SUPPORT. The Original Code may contain in whole or in part pre-release, untested, or not fully tested works. The Original Code may contain errors 

that could cause failures or loss of data, and may be incomplete or contain inaccuracies. You expressly acknowledge and agree that use of the Original Code, or any portion 

thereof, is at Your sole and entire risk. THE ORIGINAL CODE IS PROVIDED "AS IS" AND WITHOUT WARRANTY, UPGRADES OR SUPPORT OF ANY KIND AND APPLE 

AND APPLE'S LICENSOR(S) (FOR THE PURPOSES OF SECTIONS 8 AND 9, APPLE AND APPLE'S LICENSOR(S) ARE OLLECTIVELY REFERRED TO AS "APPLE") 

EXPRESSLY DISCLAIM ALL WARRANTIES AND/OR CONDITIONS, EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES 

AND/OR CONDITIONS OF MERCHANTABILITY OR SATISFACTORY QUALITY AND FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OF THIRD 

PARTY RIGHTS. APPLE DOES NOT WARRANT THAT THE FUNCTIONS CONTAINED IN THE ORIGINAL CODE WILL MEET YOUR REQUIREMENTS, OR THAT THE 

OPERATION OF  

THE ORIGINAL CODE WILL BE UNINTERRUPTED OR ERROR- FREE, OR THAT DEFECTS IN THE ORIGINAL CODE WILL BE CORRECTED. NO ORAL OR 

WRITTEN INFORMATION OR ADVICE GIVEN BY APPLE OR AN APPLE AUTHORIZED REPRESENTATIVE SHALL CREATE A WARRANTY OR IN ANY WAY 

INCREASE THE SCOPE OF THIS WARRANTY. You acknowledge that the Original Code is not intended for use in the operation of nuclear facilities, aircraft navigation, 

communication systems, or air traffic control machines in which case the failure of the Original Code could lead to death, personal injury, or severe physical or environmental 

damage. 

 

9. Liability. 

 

9.1 Infringement. If any portion of, or functionality implemented by, the Original Code becomes the subject of a claim of infringement, Apple may, at its option: (a) attempt to 

procure the rights necessary for Apple and You to continue using the Affected Original Code; (b) modify the Affected Original Code so that it is no longer infringing; or (c) 

suspend Your rights to use, reproduce, modify, sublicense and distribute the Affected Original Code until a final determination of the claim is made by a court or governmental 

administrative agency of competent jurisdiction and Apple lifts the suspension as set forth below. Such suspension of rights will be effective immediately upon Apple's posting 

of a notice to such effect on the Apple web site that is used for implementation of this License. Upon such final determination being made, if Apple is legally able, without the 

payment of a fee or royalty, to resume use, reproduction, modification, sublicensing and distribution of the Affected Original Code, Apple will lift the suspension of rights to the 

Affected Original Code by posting a notice to such effect on the Apple web site that is used for implementation of this License. If Apple suspends Your rights to Affected Original 

Code, nothing in this License shall be construed to restrict You, at Your option and subject to applicable law, from replacing the Affected Original Code with non-infringing code 

or independently negotiating for necessary rights from such third party. 

 

9.2 LIMITATION OF LIABILITY. UNDER NO CIRCUMSTANCES SHALL APPLE BE LIABLE FOR ANY INCIDENTAL, SPECIAL, INDIRECT OR CONSEQUENTIAL 

DAMAGES ARISING OUT OF OR RELATING TO THIS LICENSE OR YOUR USE OR INABILITY TO USE THE ORIGINAL CODE, OR ANY PORTION THEREOF, 

WHETHER UNDER A THEORY OF CONTRACT, WARRANTY, TORT (INCLUDING NEGLIGENCE), PRODUCTS LIABILITY  

OR OTHERWISE, EVEN IF APPLE HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES AND NOTWITHSTANDING THE FAILURE OF ESSENTIAL 

PURPOSE OF ANY REMEDY. In no event shall Apple's total liability to You for all damages under this License exceed the amount of fifty dollars ($50.00). 

 

10. Trademarks. This License does not grant any rights to use the  

trademarks or trade names "Apple", "Apple Computer", "Mac OS X", "Mac OS X Server" or any other trademarks or trade names belonging to Apple (collectively "Apple Marks") 

and no Apple Marks may be used to endorse or promote products derived from the Original Code other than as permitted by and in strict compliance at all times with Apple's 

third party trademark usage guidelines which are posted at http://www.apple.com/legal/guidelinesfor3rdparties.html. 

 

11. Ownership. Apple retains all rights, title and interest in and to  

the Original Code and any Modifications made by or on behalf of Apple ("Apple Modifications"), and such Apple Modifications will not be automatically subject to this License. 

Apple may, at its sole discretion, choose to license such Apple Modifications under this License, or on different terms from those contained in this License or may choose not to 

license them at all. Apple's development, use,  

reproduction, modification, sublicensing and distribution of Covered  

Code will not be subject to this License. 

 

12. Termination. 

 

12.1 Termination. This License and the rights granted hereunder will terminate: 

 

(a) automatically without notice from Apple if You fail to comply with any term(s) of this License and fail to cure such breach within 30 days of becoming aware of such breach; 

(b) immediately in the event of the circumstances described in Section 13.5(b); or (c) automatically without notice from Apple if You, at any time during the term of this License, 

commence an action for patent infringement against Apple. 

 

12.2 Effect of Termination. Upon termination, You agree to immediately stop any further use, reproduction, modification, sublicensing and distribution of the Covered Code and 

to destroy all copies of the Covered Code that are in your possession or control. All sublicenses to the Covered Code which have been properly granted prior to termination shall 

survive any termination of this License. Provisions which, by their nature, should remain in effect beyond the  

termination of this License shall survive, including but not limited  

to Sections 3, 5, 8, 9, 10, 11, 12.2 and 13. Neither party will be  

liable to the other for compensation, indemnity or damages of any sort solely as a result of terminating this License in accordance with its terms, and termination of this 

License will be without prejudice to any other right or remedy of either party. 

 

13. Miscellaneous. 

 

13.1 Government End Users. The Covered Code is a "commercial item" as defined in FAR 2.101. Government software and technical data rights in the Covered Code include 

only those rights customarily provided to the public as defined in this License. This customary commercial license in technical data and software is provided in accordance with 

FAR 12.211 (Technical Data) and 12.212 (Computer Software) and, for Department of Defense purchases, DFAR 252.227-7015 (Technical Data -- Commercial Items) and 

227.7202-3 (Rights in Commercial Computer Software or Computer Software Documentation). Accordingly, all U.S. Government End Users acquire Covered Code with only 

those rights set forth herein. 

 

13.2 Relationship of Parties. This License will not be construed as creating an agency, partnership, joint venture or any other form of legal association between You and Apple, 

and You will not represent to the contrary, whether expressly, by implication, appearance or otherwise. 
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13.3 Independent Development. Nothing in this License will impair Apple's right to acquire, license, develop, have others develop for it, market and/or distribute technology or 

products that perform the same or similar functions as, or otherwise compete with, Modifications, Larger Works, technology or products that You may develop, produce, market 

or distribute.  

 

13.4 Waiver; Construction. Failure by Apple to enforce any provision of this License will not be deemed a waiver of future enforcement of that or any other provision. Any law or 

regulation which provides that the language of a contract shall be construed against the drafter will not apply to this License. 

 

13.5 Severability. (a) If for any reason a court of competent jurisdiction finds any provision of this License, or portion thereof, to be unenforceable, that provision of the License 

will be enforced to the maximum extent permissible so as to effect the economic benefits and intent of the parties, and the remainder of this License will continue in full force 

and effect. (b) Notwithstanding the foregoing, if applicable law prohibits or restricts You from fully and/or specifically complying with Sections 2 and/or 3 or prevents the 

enforceability of either of those Sections, this License will immediately terminate and You must immediately discontinue any use of the Covered Code and destroy all copies of 

it that are in your  

possession or control. 

 

13.6 Dispute Resolution. Any litigation or other dispute resolution between You and Apple relating to this License shall take place in the Northern District of California, and 

You and Apple hereby consent to the personal jurisdiction of, and venue in, the state and federal courts within that District with respect to this License. The application of the 

United Nations Convention on Contracts for the  

International Sale of Goods is expressly excluded. 

 

13.7 Entire Agreement; Governing Law. This License constitutes the entire agreement between the parties with respect to the subject matter hereof. This License shall be 

governed by the laws of the United States and the State of California, except that body of California law concerning conflicts of law. 

 

Where You are located in the province of Quebec, Canada, the following clause applies: The parties hereby confirm that they have requested that this License and all related 

documents be drafted in English. Les parties ont exige que le present contrat et tous les documents connexes soient rediges en anglais. 

 

EXHIBIT A. 

 

"Portions Copyright (c) 1999 Apple Computer, Inc. All Rights Reserved. This file contains Original Code and/or Modifications of Original Code as defined in and that are subject 

to the Apple Public Source License Version 1.1 (the "License"). You may not use this file except in compliance with the License. Please obtain a copy of the License at 

http://www.apple.com/publicsource and read it before using this file. 

 

The Original Code and all software distributed under the License are  

distributed on an "AS IS" basis, WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, AND APPLE HEREBY DISCLAIMS ALL SUCH WARRANTIES, 

INCLUDING WITHOUT LIMITATION, ANY WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE OR NON- NFRINGEMENT. Please see 

the License for the specific language governing rights and limitations under the License." 

 

 


